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Abbreviations in This Document

A list of abbreviations used in this document.

Abbreviations Definition

APB Advanced Peripheral Bus

AXI4 Advanced eXtensible Interface 4
BL Burst Length

CA Command and Address

CS Chip Select

CBT Command Bus Training

DBI Data Bus Inversion

DDR Double Data Rate

DDRPHY Double Data Rate Physical Layer
DM Data Mask

DQ Data

DQS Data Strobe

ECC Error Correction Code

ECLK Edge Clock

FPGA Field Programmable Gate Array

I/F Interface

JEDEC Joint Electron Device Engineering Council
LPDDR Low Power Double Data Rate
LVSTL Low Voltage Swing Terminated Logic
MC Memory Controller

MR Mode Register

MRS Mode Register Set

oDT On-Die Termination

PRBS Pseudorandom Binary Sequence
PVT Process, Voltage, and Temperature
RTL Register Transfer Level

SCLK System Clock

SDRAM Synchronous Dynamic Random Access Memory
TCL Tool Command Language

VREF Voltage Reference
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1. Introduction

The Lattice Semiconductor DDR Memory Controller IP provides a turnkey solution consisting of a controller, DDRPHY,
and associated clocking and training logic to interface with DDR4 and LPDDR4 SDRAM. The IP Core is implemented in
System Verilog HDL using the Lattice Radiant™ software integrated with the Synplify Pro® synthesis tool. The Memory
Controller simplifies the interfacing with external DDR4 and LPDDR4 memory for user applications.

1.1. Quick Facts

Table 1.1 summarizes the DDR Memory Controller IP.

Table 1.1. Quick Facts

Supported Devices Lattice Avant, Certus-N2

IP Requirements For a list of changes to the IP, refer to the DDR Memory

IP Ch 1
Changes Controller IP Release Notes (FPGA-RN-02033)

AXI4 for data access
Supported User Interfaces

Resource Utilization APB for configuration access
Resources Refer to Table A.1 and Table A.2
Lattice Implementation? IP Core v2.7.0 — Lattice Radiant software 2025.2
Design Tool Support Synthesis Synopsys® Synplify Pro for Lattice
Simulation Questasim
Driver Support API Reference Refer to the DDR Memory Controller Driver (FPGA-TN-02379)

Notes:

1. Insome instances, the IP may be updated without changes to the user guide. This user guide may reflect an earlier IP version
but remains fully compatible with the later IP version. Refer to the IP Release Notes for the latest updates.

2. Lattice Implementation indicates the IP version release coinciding with the software version release. Check the software for IP
version compatibility with earlier or later software versions.

1.2. IP Support Summary
Table 1.2. LPDDR4 and DDR4 Memory Controller IP Support Readiness

Device Family IP Rank Vei?;h Data Rate (Mbps) 2 I\-Ilglrit‘ij\:taer: Timing Model
x16 700 to 1,600 Yes
Single x32 700 to 1,600 Yes
x64 700 to 1,600 No
x16 1,866 to 2,400 No
LPDDR4 Single x32 1,866 to 2,400 No
x64 1,866 to 2,400 No
x16 700 to 2,400 No
Avant Dual x32 700 to 2,400 No Preliminary?
x64 700 to 2,400 No
x16 1,333 to0 2,400 No
Single x32 1,333 to 2,400 No
x64 1,333 t0 2,400 No
DDR4
x16 1,333 to 2,400 No
Dual x32 1,333 t0 2,400 No
x64 1,333 to 2,400 No
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. . DDR 2 Hardware .
Device Family IP Rank Width Data Rate (Mbps) Validated Timing Model
x16 700 to 2,400 No
Single
x32 700 to 2,400 No
LPDDR4
x16 700 to 2,400 No
Dual
x32 700 to 2,400 No
Certus N2 Preliminary?
x16 1,333 to 2,400 No
Single
x32 1,333 to 2,400 No
DDR4
x16 1,333 to0 2,400 No
Dual
x32 1,333 to0 2,400 No
Notes:
1. Timing model is preliminary as the DDR characterization is not finalized.

2.

For the following Lattice Avant devices, the maximum data rate is limited to 1600Mbps for DDR Width x16 and x32, and no
support for DDR Width x64.

LAV-AT-E30B

LAV-AT-E30ES

LAV-AT-E70B

LAV-AT-E70ES1

LAV-AT-G70ES

LAV-AT-X70ES

1.3. Features

The DDR Memory Controller IP supports the following key features for DDR4 and LPDDR4 SDRAM.

1.3.1. DDR4

The Memory Controller supports the following key features when configured in DDR4 mode:

DDR4 SDRAM protocol, compliant to DDR4 JEDEC Standard
e DDR4 SDRAM speeds of:
e 666 MHz (1,333 Mbps)
e 800 MHz (1,600 Mbps)
e 933 MHz (1,866 Mbps)
e 1,066 MHz (2,133 Mbps)
e 1,200 MHz (2,400 Mbps)
DDR4-Specific Memory Controller features
e Component support for interface data widths of x16, x32, and x64
e Up to 16 Gb density support
e x8 and x16 DDR4 device support (8:1 DQ:DQS ratio)
e  Fixed burst length of BL8
e 8:1gearing mode (DDR4:FPGA logic interface clock ratio)
e Dual-rank support (requires dual rank DRAM chip)
e Configurable CAS latencies for Reads and Writes based on target interface speed
e Configurable Address widths to support various memory densities
Supports component (DRAM soldered on the board) and UDIMM.
AXl4 data interface support:
e INCR read/write operations
e Unaligned transfer using byte strobes
e Narrow transfers
e  AXI widths of 32, 64, 128 and 256
e Aligned addressing to AxSIZE only
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e  APB configuration interface support:
e Automatic DDR4 SDRAM initialization

e  Dynamic valid window optimization for Read/Write paths

e DQ-DQS skew optimization for Write training

e  Periodic training support feature:
e 7Qcalibration

e  Polling and Out-of-band interrupt support for training error

Table 1.3. DDR4 Features Overview

== LATTICE

Key Features

DDR4 Support Details!

Device Format

Component, UDIMM

Data Widths x16, x32, x64
Data User Interface AXI14
Configuration Interface APB

Maximum Data Rate

Refer to Table 1.5

HW Managed Periodic Events

Refresh

All bank auto refresh

ZQ Calibration Yes

Low Power Features Not yet supported
Other Features

Error Correction Code (ECC) Not yet supported
Dual rank Yes

Data Bus Inversion (DBI) No

On-Die Termination (ODT) Yes for DQ, No for CA
Bit Swizzle Not yet supported
Training

Initialization Yes

CS Training Not yet supported
Write Leveling Yes

Read Training Yes

Write Training Yes

VREF Training Not yet supported
Self-Calibrating Logic Yes

Bit-Level Trim Sweep Not yet supported
2-D Vref Training Not yet supported

Note:

1. Yesimplies that a configurable option exists to enable or disable the feature. No implies that the feature is currently not

supported and will not be supported in the future.
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1.3.2. LPDDR4
The Memory Controller supports the following key features when configured in LPDDR4 mode:
e |PDDR4 SDRAM protocol, compliant to LPDDR4 JEDEC Standard
e LPDDR4 SDRAM speeds of:
e 350 MHz (700 Mbps)
e 400 MHz (800 Mbps)
e 533 MHz (1,066 Mbps)
e 666 MHz (1,333 Mbps)
e 800 MHz (1,600 Mbps)
e 933 MHz (1,866 Mbps)
e 1,066 MHz (2,133 Mbps)
e 1,200 MHz (2,400 Mbps)
e LPDDR4-Specific Memory Controller features
e Component support for interface data widths of x16, x32, and x64
e Up to 16 Gb density support per channel
e x16 LPDDR4 device support (8:1 DQ:DQS ratio)
e  Burst length of BL16 and BL32, including On-The-Fly (OTF)
e 8:1gearing mode (LPDDR4:FPGA logic interface clock ratio)
e Dual-rank support (requires dual rank DRAM chip)
e Read DBI support only
e Configurable CAS latencies for Reads and Writes based on target interface speed
e Configurable Address widths to support various memory densities
e AXl4 data interface support:
e INCR read/write operations
e Unaligned transfer using byte strobes
e Narrow transfers
e AXI widths of 32, 64, 128, and 256
e Aligned addressing to AxSIZE only
e  APB configuration interface support:
e  Automatic LPDDR4 SDRAM initialization
e  Dynamic valid window optimization for Read/Write paths
e DQ-DQS skew optimization for Write training
e  Periodic training support feature:
e Temperature tracking
e Adaptive/Derate refresh rate for extended temperature support
e ZQ calibration (ZQCAL START and LATCH only)
e Automatic detection of idle triggering Self-Refresh with Power-down entry
e Polling and Out-of-band interrupt support for training error and extended temperature support
e  Bit Swizzle (DQ bit swizzle within the DQS group)
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Table 1.4. LPDDR4 Features Overview

Key Features

LPDDR4 Support Details*

Device Format Component
Data Widths x16, x32, x64
Data User Interface AXl4
Configuration Interface APB

Maximum Data Rate

Refer to Table 1.5

HW Managed Periodic Events

Refresh

All bank auto refresh

ZQ Calibration

Yes for ZQ start and latch, No for ZQ reset

Low Power Features

Self-refresh with power-down

Other Features

Error Correction Code (ECC)

Not yet supported

Dual rank

Yes

Data Bus Inversion (DBI)

Yes for reads, No for writes

Temperature Tracking

Yes

Refresh Adaptation (derate) to Temperature Variation

Yes

On-Die Termination (ODT)

Yes, for DQ and CA

Bit Swizzle Yes for DQ, Not yet supported for CA and DQS Group
Training

Initialization Yes
Command Training Yes
Write Leveling Yes
Read Training Yes
Write Training Yes
Automatic VREF Training Yes
Self-Calibrating Logic Yes
Bit-Level Trim Sweep Yes
2-D Vref Training Yes

Note:

1. Yesimplies that a configurable option exists to enable or disable the feature. No implies that the feature is currently not

supported and will not be supported in the future.
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1.4. Licensing and Ordering Information

The DDR Memory Controller IP is available with the Lattice Radiant Subscription software. To purchase the Lattice
Radiant Subscription license, contact Lattice Sales or go to the Lattice Online Store.

1.5. Hardware Support

Refer to the Running on Hardware section for more information on the boards used.

1.6. Minimum Device Requirements

== LATTICE

The DDR Memory Controller IP supports the below devices. Table 1.5 summarizes the minimum device requirements

for the Memory Controller IP Core.

Table 1.5. Minimum Device Requirements

Device/Mode DDR Data Width DDR Ranks Speed Grade Max Suppsc;)r::: utenisce
DDR4
1y 3 2,400 Mbps
Avant-E/G/X x16, x32, x64 ’ 2 2,133 Mbps
1 1 1,866 Mbps
x16, x32 1,2 3 2,400 Mbps
Certus-N2 2 2,133 Mbps
1 1 1,866 Mbps
LPDDR4
3 2,400 Mbps
Avant-E/G/X x16, x32, x64 1,2 2 2,133 Mbps
1 1 1,866 Mbps
12 3 2,400 Mbps
Certus-N2 x16, x32 2 2,133 Mbps
1 1 1,866 Mbps

1.7. Naming Conventions

This section provides information regarding terminology used within this document.

1.7.1. Nomenclature

The nomenclature used in this document is based on Verilog HDL.

1.7.2. Signal Names

Signal Names that end with:
e _nare active low

e _iareinput signals
e o areoutputsignals
e o are bi-directional input/output signals
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2. Functional Description

This section provides a detailed functional description of the DDR Memory Controller IP. It includes information
regarding clock and reset handling, available user data and configuration interfaces, the calibration sequence, and
operation descriptions.

2.1. IP Architecture

The DDR Memory Controller IP includes three main blocks: the Memory Controller, DDRPHY, and Training Engine. The
following figure shows the memory controller submodules and their connectivity.

| Memory Controller IP Core

|

| DDRPHY |

| Training |

< Configuration Interface > Engine |
CSR

Memory Controller |

|

Ordering

Queue
Memory Interface
Controller Engine
F Bus Write Data
Data Interface Interface » Buffer
Block

| Read Return Block

User Logic
\ 4

SDRAM

i

A

Read Reorder
| Buffer

DFI Interface

Figure 2.1. Memory Controller IP Core Functional Diagram

The data interface allows users to initiate command/address/control and read/write operations to external
DDR4/LPDDR4 SDRAM. The configuration interface provides access to the Training Engine and the Configuration Set
Registers (CSRs), which configure the Memory Controller and perform the DDR4/LPDDR4 training sequences. The
memory interface allows the selected Lattice FPGA to communicate with the external DDR4/LPDDR4 memory. For
more information on the data and configuration interfaces, refer to the User Interfaces section of this user guide.

2.1.1. Memory Controller

The Memory Controller consists of the following submodules:
e Bus Interface Block

e Controller Engine

e Read Return Block

2.1.1.1. Bus Interface Block

The Bus Interface Block accepts user-initiated operations on the selected data interface and translates them for
processing within the Memory Controller. The data provided for the Controller Engine consists of:

e Address interface size: determined based on the selected SDRAM device density and DDR4/LPDDR4 data width
e Read and Write interface sizes: determined based on the selected DDR4/LPDDR4 data width
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2.1.1.2. Controller Engine

The Controller Engine accepts the requests from the Bus Interface and translates the address to row, column, rank, and
bank format. The ordering queue queues for the address, command, and control information coming from the Bus
Interface Block. It prioritizes executing commands targeting an already opened bank and maintains the correct order of
execution when multiple requests target the same bank in DDR4/LPDDR4 SDRAM. The write data buffer buffers
incoming data for write commands.

The Controller Engine supports outstanding writes and reads, which are write/read requests entered into a queue and
arbitrated for processing. The following table describes the three types of requests and how they are processed.

Table 2.1. MCE Request Handling

Request type Prioritization and Definition Comments
Read Varies depending on selected data interface protocol. Refer to the | The read request size is equal to the
AXI4 Data Interface section of this user guide for details. supported DDR4/LPDDR4 burst length.
. Write requests are defined as a write, where the entire data needs Example: For.a 32-bit DDR4/LPDDR4 data
Write to be written for the supported DDR4/LPDDR4 burst length. bus width, with burst length 8 (BL8), a
full write would be 8x4B = 32B.
Example: For a 32-bit DDR4/LPDDR4 data
Partial write Partial write requests are defined as a write, where the entire data | bus width, a partial write would be a
is not written. write request that is less than 32B. This
is equivalent to a masked write.

All write requests may be processed out of order if data dependency is not present. For example, an incoming request
tied to an already opened page in DDR4/LPDDR4 SDRAM can be prioritized if it is not dependent on the requests
already in the queue. Read requests may also be processed out of order if a data dependency is not present, depending
on the selected data interface protocol. Refer to the AXI4 Data Interface section of this user guide for information
regarding outstanding write/read support.

The Controller Engine contains bank management logic to track all the open and closed pages within each bank, along
with timers for each bank and rank. This allows issued memory commands to meet the operational sequence and
timing requirements of the DDR4/LPDDR4 SDRAM. The last layer of logic within the Controller Engine handles
handshaking between the PHY and external memory. The Controller Engine is also responsible for supporting periodic
events compliant with the DDR4/LPDDR4 SDRAM requirements. For more information on supported periodic features,
refer to the Operation Descriptions section of this user guide.

2.1.1.3. Read Return Block

The Read Return Block is responsible for responding to the Controller Engine issued read requests. Execution of
commands can be out of order, so the Read Return Block handles the reordering to ensure that the read data is sent to
the Bus Interface in order. The Read Return Block also handles Data Bus Inversion (DBI), which is an 1/0 signaling
technique that reduces power consumption and improves signal integrity.

2.1.2. DDRPHY Module

The DDRPHY Module implements the DFI 4.0 Specification (© Cadence Design Systems, Inc.). It instantiates the
hardened DDRPHY Primitive and includes a dedicated PLL and quarter-rate clock generator. The DDRPHY Module
implements 8:1 gearing and trains the DDR4/LPDDR4 interface. Figure 2.2 shows a high-level block diagram of the
DDRPHY module.
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Figure 2.2. DDRPHY

2.1.2.1. Hardened DDRPHY Primitive

The PHY uses hardened logic, called I/O modules or hardware primitives, to implement clock synchronization logic and
the command/address and data input/output paths. The clock synchronization logic handles Clock Domain Crossing
(CDC) between the Edge Clock (ECLK) and System Clock (SCLK). ECLK is an internal clock that clocks the DDR primitives,
and SCLK clocks the Memory Controller IP Core. Without proper synchronization, the bit order on individual elements
might become desynchronized, causing the data bus to scramble.

The Memory Controller operates in 8:1 gearing mode, which means that ECLK operates at the same frequency as the
DDR4/LPDDR4 interface and that SCLK operates at a quarter of the DDR4/LPDDR4 memory clock. In other words, for a
400 MHz DDR4/LPDDR4 interface, ECLK operates at 800 MHz and SCLK operates at 200 MHz. This clocking ratio and
DDR transfer relationship mean the user data bus is eight times the width of the DDR4/LPDDR4 memory data bus. For
example, a 32-bit DDR4/LPDDR4 memory interface requires a 256-bit write and read data bus on the DDR PHY (DFI)
side, which is an interface protocol between the Memory Controller and PHY. For more information regarding the
DDRPHY, hardware primitives, and clock synchronization logic, refer to the DDR Memory PHY Module (FPGA-IPUG-
02195).

2.1.2.2. Training Engine

The Training Engine initializes and trains the external DDR4/LPDDR4 memory. It provides a configuration interface from
user logic to the Configuration Set Registers (CSR). You can issue commands to the Training Engine to perform reads
and writes to these registers, allowing you to handle interrupts and obtain details during the memory training
sequence. It consists of user-accessible registers, a RISC-V CPU subsystem, and a hardened PHY. For more information
regarding the training engine, refer to the DDR Memory PHY Module (FPGA-IPUG-02195).
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2.2. Clocking and Reset

The Memory Controller IP requires a differential input reference clock for DDR4 and LPDDR4 interfaces. You need to
provide this clock (pll_refclk_i) via an external source and route it to an appropriate pin on the FPGA. Refer to the
IP Parameter Description section of this user guide for a list of valid frequencies supported by the input reference clock.

The provided input clock is then routed through a dedicated PLL within the Memory Controller IP to generate the Edge
Clock (ECLK) and System Clock (SCLK). The ECLK signal is used internally by the IP Core to clock the I/0 modules, and
SCLK is used to clock the IP Core. The Primary Clock (PCLK) signal is used to implement clock synchronization logic to
synchronize SCLK and ECLK. For additional details regarding clock synchronization, refer to the DDR Memory PHY
Module (FPGA-IPUG-02195).

The Memory Controller IP contains an asynchronous active low reset: rst_n_i. When asserted, the Memory Controller
and SDRAM are reset to their default values. The IP Core contains internal logic to de-assert the internal reset signals
synchronous to the clocks (sclk_o, pclk_iand aclk_i) once rst_n_i is de-asserted, so users do not need to worry about
implementing their own de-assertion logic. The rst_n_i also resets both the AXI4 Data Interface and the APB
Configuration Interface, so please take note of the following:

e rst_n_iasserts during AXI4 transaction: You should assert the areset_n_i as well to prevent bus hang-up.

e rst_n_iasserts during AXI4 Bus Idle: No need to assert the areset_n_i.

e rst_n_iasserts during APB transaction: You should assert the preset_n_i as well to prevent bus hang-up.

e rst_n_iasserts during APB Bus Idle: No need to assert the areset_n_i.

The configuration interface for the Memory Controller operates off the pclk_i signal and is reset via the preset_n_i
signal. The clock for the configuration interface is the same one used to implement clock synchronization for SCLK and
ECLK. The preset_n_i signal is an asynchronous active low reset, where users must ensure it is synchronously de-
asserted to pclk_i. Refer to the AXI4 Data Interface section of this user guide for information regarding the clocks and
resets for the Memory Controller supported data interfaces.

2.3. User Interfaces

This section describes the supported protocols for data and configuration interfaces available to the user and
supported by the Memory Controller.

2.3.1. AXl4 Data Interface

The data interface allows you to initiate read and write operations to external SDRAM. The AXI4 |/F supports high-
bandwidth and low-latency operation. The AX14 |/F is a multi-channel bus consisting of five independent channels:
write address, read address, write data, read data, and write response channels (read response is sent along with the
read data). The AXI4 |/F operates off the aclk_i signal when the Enable Local Bus Clock attribute is checked. When the
Enable Local Bus Clock attribute is checked, the Bus Interface Block implements clock domain crossing logic to transfer
the request from AXI4 Clock (aclk_i) to the Memory Controller IP Core’s System Clock (SCLK).

The AX14 I/F is reset via the areset_n_i signal, which is an asynchronous active low reset where users must ensure it is
synchronously de-asserted to aclk_i.
The Memory Controller IP supports the following AXI4 types of burst transfers:
e  Burst Type (AXBURST):
e INCR: incrementing burst that does not wrap at address boundaries
e  Burst Size (AxSIZE):
e [1,2,3,4,8,16,32,64] Bytes
e  Burst Length (AXLEN):
e 1-64 beat burst: when IP parameter MAX_BURST _LEN =64
e 1-128 beat burst: when IP parameter MAX_BURST_LEN =128
e 1-256 beat burst: when IP parameter MAX_BURST_LEN = 256
e  Burst Address (AXADDR):
e Unaligned addressing is not supported so all transfers must be aligned to AxSIZE
e Unaligned transfer is supported by using byte strobes
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e Foraddresses not aligned to BUS_WIDTH x 16 / 8, the maximum allowable AXLEN is as defined below:
e Burst Length Offset = (BUS_WIDTH x 16) / AXI_DATA_WIDTH
e  Maximum Allowable AXLEN = MAX_BURST_LEN — Burst Length Offset
e Example Use Case: Maximum Burst Length is 64, DDR Bus Width is 32 bits and AXI Data Width is 32 bits
e  Burst Length Offset: 32 x 16/32 = 16
e Maximum Allowable AXLEN: 64 - 16 -1 =47
e  Write Strobes (WSTRB):
e  Only the first and last beats of a burst can have incomplete byte strobes (WSTRB cannot go low in middle of
burst)

The AXI4 protocol supports out-of-order transaction completion and supports multiple outstanding transactions per
bus master. As a result, when AXI4 configures as the user data interface, the Memory Controller supports up to eight
outstanding writes and eight outstanding reads, with both reads and writes having the same priority. For more
information regarding the AXI4 protocol, refer to the AMBA AXI Protocol Specification.

Table 2.2. Supported AXI4 Transactions

Transaction Type AxBURST AXLEN[7:0] AXSIZE[2:0] 1 Comment
Write INCR [0 = MAX_BURST_LEN-1] [0,1,2,3,4,5,6] [1-4,096] Byte write
Read INCR [0 — MAX_BURST_LEN-1] [0,1,2,3,4,5,6] [1-4,096] Byte read
Notes:

1. For IP parameter AXI_DATA_WIDTH = 32, AxSIZE = [0, 1, 2] are supported.

For IP parameter AXI_DATA_WIDTH = 64, AxSIZE = [0, 1, 2, 3] are supported.

For IP parameter AXI_DATA_WIDTH = 128, AxSIZE = [0, 1, 2, 3, 4] are supported.

For IP parameter AXI_DATA_WIDTH = 256, AxSIZE = [0, 1, 2, 3, 4, 5] are supported.

For IP parameter AXI_DATA_WIDTH =512, AxSIZE =0, 1, 2, 3, 4, 5, 6] are supported.
You should only start AXI4 transactions when the Initialization and Training is done. Refer to Calibration section for
more information.

2.3.2. APB Configuration Interface

The configuration interface allows you to initialize and train the memory interface. The Memory Controller IP Core
utilizes the APB protocol for its configuration interface. The APB I/F is a low-power protocol intended for accessing
programmable control registers. It is not pipelined and operates synchronously with a single address bus and two data
buses: write and read. For more information regarding the APB protocol, please refer to the AMBA APB Protocol
Specification.

The Memory Controller leverages this protocol to initialize and train the interface between FPGA logic and SDRAM. The
APB I/F operates off the pclk_i signal and resets via the preset_n_i signal. Refer to the Clocking and Reset section of this
user guide for more details.

The APB I/F is unavailable when the Enable APB I/F attribute is unchecked. For details on how to initialize and train
SDRAM without the APB I/F, refer to the Initialization and Training without APB Interface section of this user guide.

You should only start APB transaction when the PLL is locked (pll_lock_o==1).

2.4. Calibration

To ensure proper device functionality, initialize and train the external SDRAM before the Memory Controller performs
data accesses. Upon device power-up, the soft RISC-V CPU inside the Training Engine remains in reset. To start the
initialization and training sequence of the SDRAM device, execute the following steps via the configuration interface:
e  Ensure the DDRPHY Module’s PLL is in the lock state by polling the PHY Clock Register (PHY_CLOCK) until the
pll_lock signal is asserted (PHY_CLOCK[1]=1).
e Enable initialization and training by writing to the Training Operation Register (TRN_OP_REG) as follows:
e For 1,333 Mbps and below, set TRN_OP_REG=0x0DF. This enables initialization, command-bus training, write
leveling, read training, write training, and 1D Vref training sequences to run.
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e For 1,600 Mbps and 1,866 Mbps, set TRN_OP_REG=0x1DF to perform bit-level trim sweep in addition to the
above.

e For 2,133 Mbps and 2,400 Mbps, set TRN_OP_REG=0x3DF to perform bit-level trim sweep and 2D Vref
training in addition to the above. This is necessary for the two highest data rates.
For simulation purposes, shorten the initialization and training sequences (including command-bus training) by writing
0x01C to TRN_OP_REG. For more information, refer to the DDR Memory PHY Module (FPGA-IPUG-02195).
e  Pull the training CPU out of reset by writing 1’b1 to the Reset Register (RESET_REG). This begins the initialization
and training sequence.
e  Wait until initialization and training completes using one of the following methods:

e  Poll the Status Register (STATUS_REG) until the write_trn_done signal asserts (STATUS_REG[4]=1). This
indicates that write training completes, which is the final stage in the initialization and training process.

e  Wait for the trn_done_int signal (INT_STATUS_REG[0]=1) or the trn_error_int signal (INT_STATUS_REG[1]=1)
to assert in the Interrupt Status Register (INT_STATUS_REG). This method requires the trn_done_en signal
(INT_ENABLE_REG[0]=1) and the trn_err_en signal (INT_ENABLE_REG[1]=1) to be asserted in the Interrupt
Enable Register (INT_ENABLE_REG).

After completing the above steps, the PHY control transfers to the Memory Controller and you can now start accessing
the SDRAM memory through the data interface. Once init_done_o asserts, the RISC-V CPU and Training Engine enter
reset to save power.

2.4.1. Initialization and Training Sequence

The Memory Controller IP performs initialization according to the DDR4/LPDDR4 JEDEC standards. For more
information on the stages that occur during the initialization and training sequence, refer to the DDR Memory PHY
Module (FPGA-IPUG-02195).

2.4.2. Initialization and Training without APB Interface

The APB I/F is unavailable when the Enable APB I/F attribute is unchecked. In this case, the init_start_i and trn_opr_i
signals start and configure the DDR4/LPDDRA4 initialization and training. The trn_opr_i sets the value of the Training
Operation Register (TRN_OP_REG), controlling which specific training steps to perform based on the asserted bits. For
hardware implementation:

e  For 1333Mbps and below, set trn_opr_i=0x0DF to perform command bus training, write leveling, read training,
write training, and 1D Vref training procedures.

e For 1,600 Mbps and 1,866 Mbps, set trn_opr_i=0x1DF to perform Bit-Level trim sweep in addition to above.
e For 2,133 Mbps and 2,400 Mbps, set trn_opr_i=0x3DF to perform Bit-Level trim sweep and 2D Vref training, this is
necessary for the highest two data rates.

For simulation purposes, shorten the initialization and training sequences (including command bus training) by setting
trn_opr_i=0x01C. For more information regarding the initialization and training sequences and relevant registers, refer
to the DDR Memory PHY Module (FPGA-IPUG-02195).

Execute the following steps to start the initialization and training sequence of the DDR4/LPDDR4 SDRAM:
1. Setinit_start_i=0 while the Memory Controller IP is in reset or while pll_lock_0=0.
2. Wait until pll_lock_o=1 before setting init_start_i=1. Maintain this value until init_done_o asserts.

3. Once init_done_o=1, set init_start_i=0 to hold the training CPU in reset to save power.
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2.5. Operation Descriptions

This section provides details on various operations and features supported by the Memory Controller IP.

2.5.1. DDR4

The following section describes the operations supported in DDR4 mode.

2.5.1.1. Write and Read Data Access

Once the init_done_o signal asserts, you can initiate write and read accesses. The types of data accesses supported by

the Memory Controller IP depend on the selected data interface protocol. Refer to Table 2.2 for a list of all supported

AXI4 data accesses.

The Memory Controller decodes the memory-mapped address to check if the row and bank addresses are already

opened in the memory device. When a WRITE/READ command issues to DDR4 memory, the following commands issue:

e [f the target row, bank, and bank group are not open, the Memory Controller issues an ACTIVE command to the
DDR4 SDRAM to open the row. This is followed by the WRITE/READ command.

e [fthereis an open row in the current bank or bank group and the target row address is different from the open
row, the Memory Controller issues a PRECHARGE command to close the open row. This is followed by an ACTIVATE
command to open the target row, and then the WRITE/READ command.

e |f the target row is already open, the Memory Controller issues only a WRITE/READ command.

The Memory Controller does not immediately close a row after issuing a WRITE/READ command. It issues a separate
PRECHARGE command as needed.

2.5.1.2. Auto Refresh Support

Ideally, issue REFRESH commands every refresh interval, as specified by the Refresh Period attribute. To improve
efficiency in scheduling and switching between tasks, the DDR4 memory allows a maximum of eight REFRESH
commands to be postponed throughout the DDR4 operation. The Memory Controller has an internal auto refresh
generator that sends out a set of consecutive AUTO REFRESH commands to the memory once it reaches the time
specified in the following calculation: Refresh Period x No. of Outstanding Refresh.

For high-performance applications, set the Number of Outstanding Refresh to the maximum value. This increases the
DDR4 bus throughput by minimizing Memory Controller intervention.

2.5.1.3. Periodic ZQ Calibration

ZQ Calibration calibrates the output driver impedance and On-Die Termination (ODT) values across PVT. The Memory
Controller IP periodically performs ZQ Calibration as the voltage and temperature fluctuate during operation. You can
configure the frequency at which ZQ Calibration is performed and its duration via the ZQ Calibration Period and
attribute. Periodic ZQ calibration uses the DDR4 ZQ Calibration Short (ZQCS) command.

2.5.2. LPDDR4

This section describes the operations supported in LPDDR4 mode.

2.5.2.1. Write and Read Data Access

Once the init_done_o signal asserts, you can initiate write and read accesses. The types of data accesses supported by
the Memory Controller IP depend on the selected data interface protocol. Refer to Table 2.2 for a list of all supported
AXI4 data accesses.

The Memory Controller decodes the memory-mapped address to check if the row and bank addresses are already open
in the memory device. When a WRITE/READ command issues to LPDDR4 memory, the following commands issue:

e [f the target row and bank are not open, the Memory Controller issues an ACTIVATE command to the LPDDR4
SDRAM to open the row. This is followed by the WRITE/READ command.

e Ifthereis an open row in the current bank and the target row address is different from the open row, the Memory
Controller issues a PRECHARGE command to close the open row. This is followed by an ACTIVATE command to
open the target row, and then the WRITE/READ command.

e If the target row is already open, the Memory Controller issues only a WRITE/READ command.

www.latticesemi.com/legal


http://www.latticesemi.com/legal

== LATTICE

The Memory Controller does not immediately close a row after issuing a WRITE/READ command. It issues a separate
PRECHARGE command as needed.

2.5.2.2. Auto Refresh Support

Ideally, issue REFRESH commands every refresh interval, as specified by the Refresh Period attribute. To improve
efficiency in scheduling and switching between tasks, the LPDDR4 memory allows a maximum of eight REFRESH
commands to be postponed throughout the LPDDR4 operation. The Memory Controller has an internal auto refresh
generator that sends out a set of consecutive AUTO REFRESH commands to the memory once it reaches the time
specified in the following calculation: Refresh Period x Number of Outstanding Refresh.

For high-performance applications, set the Number of Outstanding Refresh to the maximum value. This increases the
LPDDR4 bus throughput by minimizing Memory Controller intervention.

2.5.2.3. Power Saving Feature

The Memory Controller supports power-saving when the Enable Power Down attribute is set. The Memory Controller IP
tracks the period of inactivity on the local data bus by monitoring the System Clock (SCLK), the main clock used by the
Memory Controller IP. When the period of inactivity on the bus reaches the value set in the Number of SCLK to enter
Self-Refresh from no traffic attribute, the Memory Controller issues SELF REFRESH and Power-Down Entry commands.
This puts the memory into Power-Down mode to save power until a new request is received on the local data bus, at
which point the Memory Controller issues SELF REFRESH and Power-Down Exit commands, followed by an additional
REFRESH command.

2.5.2.4. Periodic ZQ Calibration

ZQ Calibration calibrates the output driver impedance across PVT. There are two ZQ Calibration modes initiated with
the Multi-Purpose Command (MPC): ZQCAL START and ZQCAL LATCH. The ZQCAL START command initiates the
SDRAM'’s calibration procedure, and the ZQCAL LATCH command captures the result and loads it into the SDRAM's
drivers.

The Memory Controller IP periodically performs ZQ Calibration as the voltage and temperature may fluctuate during
operation. You can configure the frequency at which ZQ Calibration is performed and its duration via the ZQ Calibration
Period and ZQ Calibration Start to Latch attributes. Periodic ZQ calibration uses the LPDDR4 ZQ Calibration Short (ZQCS)
command.

2.5.2.5. Temperature Tracking and Extended Temperature Support

LPDDR4 SDRAM devices support temperature tracking, where the device’s refresh rate can change based on the
operational temperature. When the memory device’s temperature is within normal operating conditions, the rate is set
to 1x refresh, which is the default case. As the temperature fluctuates below or above the default case, the Memory
Controller decreases or increases the frequency of refreshes, respectively. The required refresh rate according to
temperature is specified in MR4 within LPDDR4 SDRAM. When the Temperature Update Flag (TUF) is set in MR4, it
indicates that the refresh rate has changed from the last read issued to MRA4. In this case, the Memory Controller waits
for the completion of the current refresh cycle and updates the refresh period based on MR4 for the subsequent timing
of the refresh.

LPDDR4 SDRAM devices also support operation at extended temperatures. When the operational temperature
increases beyond normal operation conditions, the refresh frequency increases. When the refresh rate in MR4 is set to
3’b110, timing derating is required for certain commands, slowing performance. For more information regarding
temperature derating timing requirements, refer to the LPDDR4 JEDEC Standard.

The Memory Controller IP periodically reads MR4 to track the temperature of the LPDDR4 memory device. Based on
the refresh rate set in MR4, the Memory Controller IP issues REFRESH commands at the required frequency. Note that
when the refresh rate in MR4 is set to either 3’'b000 or 3’b111, the LPDDR4 memory may not work as expected due to
exceeding the low/high temperature operating limits.

When the refresh rate is set to 3’b110 in MR4, the Memory Controller accommodates the temperature-derating timing
requirements when issuing commands to the memory. You can change the frequency at which the memory’s MR4
register is read through the Temperature Check Period attribute. For more information regarding supported LPDDR4
operations and relevant registers, refer to the DDR Memory PHY Module (FPGA-IPUG-02195).
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3. IP Parameter Description

The following tables show and describe the configurable attributes of the DDR Memory Controller IP. You can configure
these attributes through the IP Catalog’s Module/IP Block Wizard of the Lattice Radiant software. Refer to the
Designing and Simulating the IP section of this user guide for information on how to configure and generate the
Memory Controller IP.

3.1. DDR4

This section describes the parameters available in DDR4 mode.

3.1.1. General
This section describes the parameters available in the General tab of the IP parameter editor.

Table 3.1. DDR4 General Attributes

Attribute Selectable Values Default Dependency on Other Attributes
Interface Type DDR4 DDR4 —
1/0 Buffer Type POD12 POD12 Display only
DDR Command Frequency (MHz)* 666, 800, 933, 1066, 1200 800 —
Gearing Ratio 8:1 8:1 Display only
Enable Sideband ECC Checked, Unchecked Unchecked Display only
Enable Power Down? Checked, Unchecked Unchecked Display only
10 10 DDR Command Frequency = 666 MHz
10,11, 12 12 DDR Command Frequency = 800MHz
Read Latency 12,13,14 12 DDR Command Frequency = 933MHz
14,15, 16 14 DDR Command Frequency = 1,066MHz
15, 16,17, 18 16 DDR Command Frequency = 1,200MHz
9 9 DDR Command Frequency = 666MHz
9,11 9 DDR Command Frequency = 800MHz
Write Latency 10, 12 10 DDR Command Frequency = 933MHz
11,14 11 DDR Command Frequency = 1,066MHz
12,16 12 DDR Command Frequency = 1,200MHz
Display only
Enable Internal RISC-V CPU Checked, Unchecked Checked (Disabling of Internal RISC-V CPU is not yet
supported)
Notes:

1. Devices with speed grades of 2 and 3 support DDR command frequencies up to 1,066 MHz, while devices with a speed grade of
3 can support frequencies up to 1,200 MHz.
2. The Enable Power Down attribute is hidden due to the known issues mentioned in Appendix B.

Table 3.2. DDR4 Clock Settings Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Enable PLL Checked Checked Display only

Reference Clock Frequency (MHz) Integer 100.0 —
Display only

DDR M A | F

(MHz) emory Actual Frequency Calculated N/A Based on the selection for DDR Command
Frequency
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Table 3.3. DDR4 Memory Configuration Attributes

Attribute Selectable Values Default Dependency on Other Attributes
DDR Density (per Channel) 2 Gb, 4 Gb, 8 Gb, 16 Gb 4 Gb —

DDR Bus Width (DDR_WIDTH) 16, 32, 64 32 —

Configuration x8, x16 x16 —

Number of Ranks (CS_WIDTH)?! 1,2 1 —

Number of DDR Clocks 19 1 _

(CK_WIDTH) !

Note:

1. Devices with speed grades of 2 and 3 support Dual Rank.

Table 3.4. DDR4 Local Data Bus Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Local Data Bus Type AXlI4 AXI14 Display only
Display only

Address Width Calculated N/A Calculated based on selection for DDR
Density

Data Width 32 64, 128, 256, 512 256 gzlsc;‘l/z;\‘t;: based on the selection for DDR

ID Width 1,2,3,4,5,6,7,8 4 —

Maximum Burst Length 64,128, 256 64 —

Write Ordering Queues 1,2,3,4 2 —

Read Ordering Queues 1,2,3,4 2 —

Enable Local Bus Clock Checked, Unchecked Checked —

Enable APB I/F Checked, Unchecked Checked —

Table 3.5. DDR4 General Definitions
Attribute ‘ Description

General Group

Interface Type

Specifies the SDRAM Memory interface: DDR4

1/0 Buffer Type

I/0 Standard for the memory interface signals
This is fixed to POD12 for DDR4, but the command/address/control signals should be
terminated to VTT on the board. Please see note 2 of Table 4.9.

DDR Command Frequency (MHz)

Speed at which the memory controller will issue commands to the memory device

Gearing Ratio

Specifies the ratio relationship between the DDR data speed and the memory controller
speed

Enable Power Down

Enables memory controller automatically placing the memory device into power-down
mode after a specified number of idle controller clock cycles (not yet supported)

Enable DBI

Enables data bus inversion (DBI) for better signal integrity and read/write margins

Read Latency

Specifies the delay from issuing a read command to receiving of read data from SDRAM.
Set this based on the target DRAM’s datasheet.

Write Latency

Specifies the delay from issuing a write command to providing of write data to SDRAM.
Set this based on the target DRAM’s datasheet.

Enable Internal RISC-V CPU

Enables RISC-V subsystem to support initialization and training of the memory device
(disabling is not yet supported)
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Attribute ‘ Description
Clock Settings Group
Enable PLL Enables PLL

Reference Clock: Frequency (MHz)

Indicates the PLL reference clock speed

DDR Memory Actual Frequency
(MHz)

Specifies the actual operating frequency of the memory interface (calculated by the PLL —
includes tolerance)

Memory Configuration Group

DDR Density (per Channel)

Density of SDRAM (number of chips on memory module). Only DDR Density with power of
2 is supported.

DDR Bus Width

Total number of data pins in memory interface

Configuration

Specifies the DRAM'’s Configuration as x8 or x16. The x4 is not supported.
Set this based on the target DRAM’s datasheet.

Number of Ranks

Specifies number of ranks in memory interface

Number of DDR Clocks

Specifies the number of CK/CK# clock pairs to be driven to SDRAM

Local Data Bus Group

Local Data Bus Type

Indicates bus for local data interface: AXI4 or NATIVE

Address Width

Specifies the number of address pins in memory interface, dependent on the SDRAM
density

Data Width (AXI_DATA_WIDTH)

Indicates data width for local data bus

ID Width

Indicates bit width of AXI4 ID

Maximum Burst Length

Specifies the maximum AXI4 burst length. Recommended to set based on system
requirements to save EBR resources.

Local Data Bus Group

Write Ordering Queues

Read Ordering Queues

The number of write/read ordering queues process write and read data requests. The
higher the value, the better bandwidth on the interface since gaps between accesses is
lessened at the cost of consuming more LUTs.

Enable Local Bus Clock

Enables clock domain crossing logic for the local data bus.

Enable APB I/F

Enables APB interface. Should be enabled if the target application includes a CPU. When
disabled, initialization and training of SDRAM should be handled via init_start_i and
trn_opr_i signals. Please refer to the Initialization and Training without APB Interface
section of this User Guide for more information.

3.1.2. Memory Device Timing

This section describes the parameters available in the Memory Device Timing tab of the IP parameter editor. The
default value of the attributes listed under the Memory Device Timing Setting Group is different for each DDR
Command Frequency value and is based on JESD79-4D SDRAM standard. These values may need to be manually
adjusted based on the selected DDR4 device.

Table 3.6. DDR4 Memory Device Timing Setting Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Manual Timing Adjust Enable Checked/Unchecked Unchecked —

TRCD (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRAS (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRPPB (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TWR (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRTP (tCLK) 8 -65,536 Calculated Enabled when Manually Adjust is Checked
TCCD (tCLK) 8-65,536 Calculated Enabled when Manually Adjust is Checked
TRRD (tCLK) 6 —65,536 Calculated Enabled when Manually Adjust is Checked
TRFC (tCLK) 24 — 28,080 Calculated Enabled when Manually Adjust is Checked
TFAW (tCLK) 40 - 65,536 Calculated Enabled when Manually Adjust is Checked
TZQCAL (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
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Attribute Selectable Values Default Dependency on Other Attributes

TMRD (tCLK) 10-65,536 Calculated Enabled when Manually Adjust is Checked
TRPAB (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TDQSS (tCLK) Integer 0 Enabled when Manually Adjust is Checked
TRD2PRE (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TWR2PRE (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TXP (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TXPSR (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked

Table 3.7. DDR4 Periodic Event Setting Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Number of SCLK to er?ter Self Integer 5,000 Enabled when Enable Power Down is

Refresh from no traffic Checked

Refresh Period (tSCLK) Calculated Calculated Defau!t value is calculated based on
selection for DDR Command Frequency

Number of Outstanding Refresh 1,2,3,4,5,6,7 7 —

ZQ Calibration Period (sec) Integer 32 —

ZQ Calibration Start to Latch (usec) Integer 1 —

Temperature Check Period (sec) Integer 32 —

Table 3.8. DDR4 Memory Device Timing Definitions

Attribute

‘ Description

Memory Device Timing Setting Group*

Manual Timing Adjust Enable Enables you to manually set any of the memory timing parameters
Indicates the delay between the ACTIVATE command (RAS) and the internal access to data

TRCD
(CAS)

TRAS Indicates how long memory must wait after an ACTIVATE command before a PRECHARGE
command can be issued to close the row

TRPPB Row PRECHARGE time for a single bank

TWR Specifies the amount of clock cycles needed to complete a WRITE before a PRECHARGE
command can be issued

TRTP Internal READ to PRECHARGE delay

TCCD Minimum time between two READ/WRITE (CAS) commands (burst length / 2)

TRRD Minimum time interval between two ACTIVATE commands to different banks

TREC Indicates how long memory must wait after a REFRESH command before an ACTIVATE
command can be accepted by memory

TFAW Specifies the period duration during which only four banks can be active

TZQCAL ZQ calibration time from START to LATCH command

TMRD Minimum time between two MRS commands

TRPAB Row PRECHARGE time for all banks
Describes skew between the output data strobe with respect to the memory clock for

TDQSS .
writes (DQS to CK)

TRD2PRE READ to PRECHARGE time

TWR2PRE WRITE to PRECHARGE time

TXP Power-down exit latency to next valid command

TXPSR Power-down exit latency to next self-refresh
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Attribute Description
Periodic Event Setting Group
Number of SCLK to enter Self- The memory controller puts the memory in self-refresh when there is no traffic for the
Refresh from no traffic specified number of SCLK cycles
Refresh Period Specifies the number of SCLK cycles between refresh commands

Number of Outstanding Refresh

Specifies the maximum number of outstanding refresh commands. Refer to the Auto
Refresh Support section of this user guide for more information

ZQ Calibration Period Indicates period for performing ZQ Calibration in seconds

ZQ Calibration Start to Latch Indicates time from start to latch during ZQ Calibration in microseconds

Temperature Check Period Indicates period for reading the temperature register (MR4) in DDR4 memory in seconds
Note:

1. The memory device timing parameters listed under the Memory Device Timing tab are defined according to the JESD79-4D
SDRAM standard. Refer to the memory device data sheet for detailed descriptions and allowed values for these parameters.

3.1.3. Training Settings

This section describes the parameters available in the Training Settings tab of the IP parameter editor.

Table 3.9. DDR4 Training Settings Attributes

480,400,340

Attribute Selectable Values Default Dependency on Other Attributes
DDR Clock Delay Value 0-20 15 -

DDR Clock Delay Value Incr/Decr Checked, Unchecked Checked —

CS Delay Value 0-20 15 —

CS Delay Value Incr/Decr Checked/Unchecked Checked —

Address Control Delay Value 0-20 4 —

ﬁi‘:};ifontro' Delay Value Checked, Unchecked Unchecked —

Memory DQ_Vref Value for Rank0 | 0-114 90 —

Memory DQ_Vref Value for Rankl | 0-114 90 Enabled when Number of Ranks==2
MC DQS Grp<0,1> Vref Value 0-127 80 -

MC DQS Grp<2,3> Vref Value 0-127 80 Enabled when DDR Bus Width> 32
MC DQS Grp<4,7> Vref Value 0-127 80 Enabled when DDR Bus Width>64

Table 3.10. DDR4 MC I/0 Settings Attributes

Attribute Selectable Values Default Dependency on Other Attributes
CK/CS Slew Rate Slow, Fast Fast —

Command Address Slew Rate Slow, Fast Fast —

DQS Slew Rate Slow, Fast Fast -

DQ/DMI Slew Rate Slow, Fast Fast —

240Q,1200,68Q, 60 Q,
MC CA Output Impedance 480,400,340 34 Q —
2400,1200,68Q,600Q,
MC DQ Output Impedance 480,400,340 340 -
MC ODT Value 2400,1200,68 Q, 60 Q, 600 _
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Table 3.11. DDR4 Memory ODT Settings Attributes

Attribute

Selectable Values Default Dependency on Other Attributes

RTT_WR Value

Dynamic ODT OFF, RZQ/1, | Dynamic ODT
RzQ/2, RzQ/3, Hi-Z OFF

Disable, RzQ/1, RzQ/2,

RTT_NOM Value RzQ/3, RZQ/4, RZQ/5, RzQ/5 —
RzQ/6, RZQ/7
Disable, RZQ/1, RZQ/2,

RTT_PARK Value RzQ/3, RZQ/4, RZQ/5, Disable -
RzQ/6, RZQ/7

Table 3.12. DDR4 Training Settings Definitions

Attribute?

‘ Description

Training Settings

DDR Clock Delay Value

Specifies the DDR clock delay so that the first DQS toggle is at CK = 0 during write leveling. It
is recommended to increase this value if write leveling fails

DDR Clock Delay Value Incr/Decr

Specifies the adjustment direction
Checked: DDR Clock Delay Value is added to the ddr_ck_o signal
Unchecked: DDR Clock Delay Value is subtracted from the ddr_ck_o signal

CS Delay Value

Specifies the DDR CS delay value

CS Delay Value Incr/Decr

Specifies the adjustment direction
Checked: CS Delay Value is added to the ddr_cs_o signal
Unchecked: CS Delay Value is subtracted from the ddr_cs_o signal

Address Control Delay Value

Specifies the DDR address/control signals delay. It is recommended to increase this value if
command bus training fails

Address Control Delay Value
Incr/Decr

Specifies the adjustment direction

Checked: Address Control Delay Value is added to the DDR address/control signals
Unchecked: Address Control Delay Value is subtracted from the DDR address/control
signals

Memory DQ_Vref Value for
Rank<0,1>

Specifies the DRAM DQ_Vref Value to be written to DDR4 DRAM’s MR6 Vref DQ Training
Value and Vref DQ Training Range for RankO/Rank1. When the register field
TRN_OP_REG.mem_vref_training_en=0, this will be used as the final DRAM DQ Vref.
Please refer to DDR4 JEDEC Standard for the allowed values in MR6

MC DQS Grp<0,1> Vref Value

Specifies the MC DQ_Vref Value for each DQS group when DQ_Vref training is disabled by
setting TRN_OP_REG.mc_vref_training_en=0.
The theoretical mV value is: Vref decimal value x 5mV

DDR4 MC I/0 Settings

CK/CS Slew Rate

Specifies the CK/CS driver strength

Command Address Slew Rate

Specifies the CA driver strength

DQS Slew Rate

Specifies the DQS driver strength

DQ/DMI Slew Rate

Specifies the DQ/DMI driver strength

MC CA Output Impedance

Memory controller CA I/O impedance to reach VDDQ threshold

MC DQ Output Impedance

Memory controller DQ |/O impedance to reach VDDQ threshold

MC ODT Value Memory controller termination resistance value at FPGA
DDR4 Memory ODT Settings
RTT_WR Value Specifies the RTT_WR value that is written to MR2 in DDR4 memory

RTT_NOM Value

Specifies the RTT_NOM value that is written to MR1 in DDR4 memory

RTT_PARK Value

Specifies the RTT_PARK value that is written to MR5 in DDR4 memory

Note:

1. These attributes should only be modified when an error is encountered during DDR4 memory training.
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3.2. LPDDR4

This section describes the parameters available in LPDDR4 mode.

3.2.1. General

This section describes the parameters available in the General tab of the IP parameter editor.

Table 3.13. LPDDR4 General Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Interface Type LPDDR4 LPDDR4 Display only

I/O Buffer Type LVSTL11 I, LVSTL11 Il LVSTL1L_ | —

350, 400, 533, 666, 800,

DDR Command Frequency (MHz)? 933, 1066, 1200 800 —

Gearing Ratio 8:1 8:1 Display only

Enable Power Down? Checked, Unchecked Unchecked Display only

Enable Read DBI Checked, Unchecked Unchecked Fixed to En.abled when DDR Command
Frequency is 400 or less
Display only

Read Latency Calculated N/A Calculated based off selection for DDR
Command Frequency
Display only

Write Latency Calculated N/A Calculated based off selection for DDR
Command Frequency
Display only

Enable Internal RISC-V CPU Checked, Unchecked Checked (Disabling of Internal RISC-V CPU is not yet
supported)

Enable Reveal Debug Checked, Unchecked Unchecked —

Enable Bit Swizzle Checked, Unchecked Unchecked —

Notes:

1. Devices with speed grades of 2 and 3 support DDR command frequencies up to 1,066 MHz, while devices with speed grades of
3 support frequencies up to 1,200 MHz.
2. The Enable Power Down option is hidden due to the known issue mentioned in Appendix B.

Table 3.14. LPDDR4 Clock Settings Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Enable PLL Checked Checked Display only

Reference Clock: Frequency (MHz) | 25.0, 50.0, 100.0 100.0 —
Display only

DD

(MSZI;/Iemory Actual Frequency Calculated N/A Based on the selection for DDR Command
Frequency

Table 3.15. LPDDR4 Memory Configuration Attributes

Attribute Selectable Values Default Dependency on Other Attributes
DDR Density (per Channel) 2 Gb, 4 Gb, 8 Gb, 16 Gb 4 Gb —
DDR Bus Width (DDR_WIDTH) 16, 32, 64 32 —
Number of Ranks (CS_WIDTH)?! 1,2 1 —
Number of DDR Clocks 19 1 .
(CK_WIDTH) ’
Note:

1. Devices with speed grades of 2 and 3 support Dual Rank.
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Table 3.16. LPDDR4 Local Data Bus Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Local Data Bus Type AXl14 AXl4 —
Display only

Address Width Calculated N/A Calculated based on the selection for DDR
Density

Data Width (AXI_DATA_WIDTH) 32, 64,128, 256 256 —

ID Width 1,2,3,4,56,7,8 4 —

Maximum Burst Length 64,128, 256 64 —

Write Ordering Queues 1,2,3,4 2 —

Read Ordering Queues 1,2,3,4 2 —

Enable Local Bus Clock Checked, Unchecked Checked —

Enable APB I/F Checked, Unchecked Checked —

Table 3.17. LPDDR4 General Definitions

Attribute

‘ Description

General Group

Interface Type

Specifies the SDRAM Memory interface: LPDDR4

1/0 Buffer Type

I/0 Standard for the memory interface signals

DDR Command Frequency (MHz)

Speed at which the memory controller will issue commands to the memory device

Gearing Ratio

Specifies the ratio relationship between the DDR data speed and the memory controller
speed

Enable Power Down

Enables memory controller automatically placing the memory device into power-down
mode after a specified number of idle controller clock cycles (not yet supported)

Enable DBI

Enables data bus inversion (DBI) for better signal integrity and read/write margins (not yet
supported)

Read Latency

Specifies the delay from issuing a read command to receiving of read data from SDRAM

Write Latency

Specifies the delay from issuing a write command to providing of write data to SDRAM

Enable Internal RISC-V CPU

Enables RISC-V subsystem to support initialization and training of the memory device
(disabling is not yet supported)

Enable Reveal Debug

Enables the Reveal debug tool to connect to the MC for improved training debug
Please see the Reveal User Guide for Radiant Software for more information.

Enable Bit Swizzle

Enables Bit Swizzle feature. Once checked, the Bit Swizzle Tab will be shown in the IP GUI.
You can enable this if swizzling the DQ bit connection on the board will improve the
LPDDR4 signal routing on the board. Please refer to Bit Swizzle section of DDR Memory PHY
Module (FPGA-IPUG-02195) for more information about this feature.

Clock Settings Group

Enable PLL

Enables PLL

Reference Clock: Frequency (MHz)

Indicates the PLL reference clock speed

DDR Memory Actual Frequency
(MHz)

Specifies the actual operating frequency of the memory interface (calculated by the PLL —
includes tolerance)

Memory Configuration Group

DDR Density (per Channel)

Density of SDRAM (number of chips on memory module). Only DDR Density with power of
2 is supported

DDR Bus Width

Total number of data pins in memory interface

Number of Ranks

Specifies number of ranks in memory interface

Number of DDR Clocks

Specifies the number of CK/CK# clock pairs to be driven to SDRAM
(multiple clocks is not yet supported)

Local Data Bus Group

Local Data Bus Type

Indicates bus for local data interface: AXI4 or NATIVE

Address Width

Specifies number of address pins in memory interface, dependent on the SDRAM density
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Attribute Description
Data Width Indicates data width for local data bus
ID Width Indicates bit width of AX14 ID

Maximum Burst Length

Specifies the maximum AXI4 burst length. Recommended to set based on system
requirements to save EBR resources

Write Ordering Queues

Read Ordering Queues

The number of write/read ordering queues process write and read data requests. The
higher the value, the better bandwidth on the interface since gaps between accesses is
lessened at the cost of consuming more LUTs

Enable Local Bus Clock

Enables clock domain crossing logic for the local data bus

Enable APB I/F

Enables APB interface. Should be enabled if the target application includes a CPU. When
disabled, initialization and training of SDRAM should be handled via init_start_i and
trn_opr_i signals. Please refer to the Initialization and Training without APB Interface
section of this User Guide for more information.

3.2.2. Memory Device Timing

This section describes the parameters available in the Memory Device Timing tab of the IP parameter editor. The
default value for the attributes listed under Memory Device Timing Setting Group is different for each DDR Command
Frequency value and is based on JESD209-4C SDRAM standard. These values may need to be manually adjusted based

on the selected LPDDR4 device.

Table 3.18. LPDDR4 Memory Device Timing Setting Attributes

Attribute Selectable Values Default Dependency on Other Attributes
Manual Timing Adjust Enable Checked/Unchecked Unchecked —
TRCD (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRAS (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRPPB (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TWR (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TRTP (tCLK) 8-65,536 Calculated Enabled when Manually Adjust is Checked
TCCD (tCLK) 8-65,536 Calculated Enabled when Manually Adjust is Checked
MWR2MWR (tCLK) 32-65,536 Calculated Enabled when Manually Adjust is Checked
TRRD (tCLK) 6 —-65,536 Calculated Enabled when Manually Adjust is Checked
TRFC (tCLK) 24 - 28,080 Calculated Enabled when Manually Adjust is Checked
TFAW (tCLK) 40 - 65,536 Calculated Enabled when Manually Adjust is Checked
TZQCAL (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TMRR2WR (tCLK) 8-65,536 Calculated Enabled when Manually Adjust is Checked
TMRD (tCLK) 10-65,536 Calculated Enabled when Manually Adjust is Checked
TRPAB (tCLK) 4 -65,536 Calculated Enabled when Manually Adjust is Checked
TRTW (tCLK) 21-65,536 Calculated Enabled when Manually Adjust is Checked
TDQSS (tCLK) Integer 1 Enabled when Manually Adjust is Checked
TRD2PRE (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TWR2PRE (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TXP (tCLK) 4-65,536 Calculated Enabled when Manually Adjust is Checked
TXPSR (tCLK) 4 -65,536 Calculated Enabled when Manually Adjust is Checked
Table 3.19. LPDDR4 Periodic Event Setting Attributes
Attribute Selectable Values Default Dependency on Other Attributes
No. of SCLK to enter S.elf Integer 5000 Enabled when Enable Power Down is
Refresh from no traffic ! Checked
Refresh Period (tSCLK) Calculated Calculated Default value is calculated based off

selection for DDR Command Frequency
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Attribute Selectable Values Default Dependency on Other Attributes
No. of Outstanding Refresh 1,2,3,4,5,6,7 7 -
ZQ Calibration Period (sec) Integer 32 —
ZQ Calibration Start to Latch
Integer 1 —
(usec)
Temperature Check Period (sec) | Integer 32 —

Table 3.20. LPDDR4 Memory Device Timing Definitions

Attribute

‘ Description

Memory Device Timing Setting Group*

Manual Timing Adjust Enable

Enables you to manually set any of the memory timing parameters

Indicates the delay between the ACTIVATE command (RAS) and the internal access to data

TRCD (CAS)

TRAS Indicates how long memory must wait after an ACTIVATE command before a PRECHARGE
command can be issued to close the row

TRPPB Row PRECHARGE time for a single bank

TWR Specifies the amount of clock cycles needed to complete a WRITE before a PRECHARGE
command can be issued

TRTP Internal READ to PRECHARGE delay

TCCD Minimum time between two READ/WRITE (CAS) commands (burst length / 2)

MWR2MWR Masked WRITE to masked WRITE time

TRRD Minimum time interval between two ACTIVATE commands to different banks

TREC Indicates how long memory must wait after a REFRESH command before an ACTIVATE
command can be accepted by memory

TFAW Specifies the period duration during which only four banks can be active

TZQCAL ZQ calibration time from START to LATCH command

TMRR2WR Mode register READ command to Write command time

TMRD Minimum time between two MRS commands

TRPAB Row PRECHARGE time for all banks

TRTW READ to WRITE command delay

TDQSS Deécribes skew between the output data strobe with respect to the memory clock for
writes (DQS to CK)

TRD2PRE READ to PRECHARGE time

TWR2PRE WRITE to PRECHARGE time

TXP Power-down exit latency to next valid command

TXPSR Power-down exit latency to next self-refresh

Periodic Event Setting Group

Number of SCLK to enter Self-
Refresh from no traffic

The memory controller puts the memory in self-refresh when there is no traffic for the
specified number of SCLK cycles

Periodic Event Setting Group

Refresh Period

Specifies the number of SCLK cycles between refresh commands

Number of Outstanding Refresh

Specifies the maximum number of outstanding refresh commands. Refer to the Auto
Refresh Support section of this User Guide for more information.

ZQ Calibration Period

Indicates period for performing ZQ Calibration in seconds

ZQ Calibration Start to Latch

Indicates time from start to latch during ZQ Calibration in microseconds

Temperature Check Period

Indicates period for reading the temperature register (MR4) in LPDDR4 memory in seconds

Note:

1. The memory device timing parameters listed under the Memory Device Timing tab are defined according to the JESD209-4C
SDRAM standard. Refer to the memory device data sheet for detailed descriptions and allowed values for these parameters.
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3.2.3. Training Settings

This section describes the parameters available in the Training Settings tab of the IP parameter editor.

Table 3.21. LPDDR4 Training Settings Attributes

RzQ/4, RzQ/5, RZQ/6

Attribute Selectable Values Default Dependency on Other Attributes
DDR Clock Delay Value 0-20 0 —
DDR Clock Delay Value Incr/Decr Checked, Unchecked Checked —
CS Delay Value 0-20 0 -
CS Delay Value Incr/Decr Checked/Unchecked Checked —
Address Control Delay Value 0-20 0 —
ﬁ]dcf;gsesc::ontrol Delay Value Checked, Unchecked Unchecked —
Memory CA_Vref Value for Rank0 0-114 25 —
Memory CA_Vref Value for Rank1 0-114 25 Enabled when Number of Ranks==2
Memory DQ_Vref Value for Rank0 | 0-114 25 —
Memory DQ_Vref Value for Rankl | 0-114 25 Enabled when Number of Ranks==2
MC DQS Grp<0,1> Vref Value 0-127 40 -
MC DQS Grp<2,3> Vref Value 0-127 40 Enabled when DDR Bus Width>32
MC DQS Grp<4,7> Vref Value 0-127 40 Enabled when DDR Bus Width>64
Table 3.22. LPDDR4 MC I/0 Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
CK/CS Slew Rate Slow, Fast Fast —
Command Address Slew Rate Slow, Fast Fast —
DQS Slew Rate Slow, Fast Fast —
DQ/DMI Slew Rate Slow, Fast Fast —
MC CA Output Impedance 421:00(,)’4(1)2()0, (3);165 0,600, 340 —
2400,1200, 68 Q, 60 Q,
MC DQ Output Impedance 480,400,340 340 -
2400,1200,68 Q, 60 Q,
MC ODT Value 480,400Q,34Q 48 Q —
Table 3.23. LPDDR4 Memory ODT Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
Disable, RZQ/1, RZQ/2,
CA_ODT Value RzQ/3, RzQ/4, RZQ/5, RzQ/2 —
RzQ/6
Disable, RZQ/1, RZQ/2,
DQ_ODT Value RzQ/3, RzQ/4, RZQ/5, RzQ/4 —
RzQ/6
Disable, RZQ/1, RZQ/2,
SoC_ODT Value RzQ/3, RzQ/4, RZQ/5, RZQ/6 —
RzQ/6
CK_ODT Override Enable Checked, Unchecked Unchecked —
CS_ODT Override Enable Checked, Unchecked Unchecked —
CA_ODT Override Disable Checked, Unchecked Unchecked —
ODT-CS/CA/CLK Disable Checked, Unchecked Unchecked —
Pull-Down Drive Strength RZQ/1,R2Q/2, RZQ/3, RzZQ/6 —
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Table 3.24. LPDDR4 Training Settings Definitions

Attribute?!

Description

LPDDRA4 Training Settings

DDR Clock Delay Value

Specifies the DDR clock delay so that the first DQS toggle is at CK = 0 during write leveling. It
is recommended to increase this value if write leveling fails

DDR Clock Delay Value Incr/Decr

Specifies the adjustment direction
Checked: DDR Clock Delay Value is added to the ddr_ck_o signal
Unchecked: DDR Clock Delay Value is subtracted from the ddr_ck_o signal

CS Delay Value

Specifies the DDR CS delay value

CS Delay Value Incr/Decr

Specifies the adjustment direction
Checked: CS Delay Value is added to the ddr_cs_o signal
Unchecked: CS Delay Value is subtracted from the ddr_cs_o signal

Address Control Delay Value

Specifies the DDR address/control signals delay. It is recommended to increase this value if
command bus training fails

Address Control Delay Incr/Decr

Specifies the adjustment direction.

Checked: Address Control Delay Value is added to the DDR address/control signals
Unchecked: Address Control Delay Value is subtracted from the DDR address/control
signals

Memory CA_Vref Value for
Rank<0,1>

Specifies the DRAM CA_Vref Value to be written to LPDDR4 DRAM’s MR12 VR-CA and
VREF(CA) for Rank0/Rank1. This should be set based on SI/PI simulation for the target
board design.

Please refer to LPDDR4 JEDEC Standard for allowed values in MR12.

Memory DQ_Vref Value for
Rank<0,1>

Specifies the DRAM DQ_Vref Value to be written to LPDDR4 DRAM’s MR14 VR(DQ) and
VREF(DQ) for RankO/Rank1. When the register field
TRN_OP_REG.mem_vref_training_en=0, this will be used as the final DRAM DQ Vref.
Please refer to LPDDR4 JEDEC Standard for allowed values in MR14.

MC DQS Grp<0,1> Vref Value

Specifies the MC DQ_Vref Value for each DQS group when DQ_Vref training is disabled by
setting the register field TRN_OP_REG.mc_vref_training_en=0.
The theoretical mV value is: Vref decimal value * 5mV.

LPDDR4 MC I/0 Settings

CK/CS Slew Rate

Specifies the CK/CS driver strength

Command Address Slew Rate

Specifies the CA driver strength

DQS Slew Rate

Specifies the DQS driver strength

DQ/DMI Slew Rate

Specifies the DQ/DMI driver strength

MC CA Output Impedance

Memory controller CA I/O impedance to reach VDDQ threshold

MC DQ Output Impedance

Memory controller DQ I/O impedance to reach VDDQ threshold

MC ODT Value

Memory controller termination resistance value at FPGA

LPDDR4 Memory ODT Settings

CA_ODT Value

Memory side CA ODT resistance value

DQ_ODT Value

Memory side DQ ODT resistance value

SoC_ODT Value

Memory controller ODT resistance value correlating to ZQ calibration

CK_ODT Override Enable

Overrides the default CK ODT value for the non-terminating rank when option is checked.
Refer to MR22 in LPDDR4 device datasheet for more details

CS_ODT Override Enable

Overrides the default CS ODT value for the non-terminating rank when option is checked.
Refer to MR22 in LPDDR4 device datasheet for more details

CA_ODT Override Disable

Disable termination for CA when option is checked. Refer to MR22 in LPDDR4 device
datasheet for more details

ODT-CS/CA/CLK Disable

Disable ODT for CS/CA/CLK when option is checked

Pull-Down Drive Strength

Memory side pull-down drive strength value

Note:
1. These attributes should only be modified when an error is encountered during LPDDR4 memory training.
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This section describes the parameters available in the Example Design tab of the IP parameter editor. Use these options
when implementing the LPDDR4 Example Design to a Lattice board for Avant-E/G/X70.

Table 3.25. LPDDR4 Example Design Attributes

(MHz)

Attribute Selectable Values Default Dependency on Other Attributes
None,
Avant-E_Evaluation_Board, If Avant E/G/X70 device
Select Development Board Avant-E_Development_Board, None
Avant-G/X_Versa_Board
None If not Avant E/G/X70 device
Use internal OSC for Eval PLL Checked If Select Development Board == None
Checked, Unchecked
Refclk Unchecked If Select Development Board != None
LVDS, SUBLVDS, SLVS,
HSTL15_I, HSTL15D_|,
LVSTLL1D_|, LVTTL33, Available when Use internal OSC for Eval
LVCMOS33, LVCMOS25, .
, - , PLL Refclk is Unchecked
Eval PLL Refclk I/O Buffer Type LVCMOS18', 'LVCMOS18H', Calculated The default value i lculated based
'HSTL15D_I', 'LVCMOS15', " ese/ a‘:D"a ‘;e s ca ;‘;a ed :ts?b ‘E”
'LVCMOS15H', 'LVCMOS12, e Select Development Board attribute
'LVCMOS12H', 'LVCMOS10H',
'LVCMOS10', 'LVCMOS10R'
50, 125 50 If Select Development Board == None
Eval PLL Refclk Frequency (MHz)
125 125 If Select Development Board != None
Eval Local Bus Clock Frequency 80, 250 250 Available when Enable Local Bus Clock is

Checked

Table 3.26. LPDDR4 Example Design Attribute Definitions

Attribute

Description

Select Development Board

Specifies the Lattice board where the LPDDR4 Example design will be implemented.
The pin assignments for the target board will be automatically added to the
eval/constraint.pdc (see Table 7.2). When implementing the LPDDR4 Example Design to
your board, please select None

Use internal OSC for Eval PLL
Refclk

Specifies the source of the PLL reference clock in the LPDDR4 Example Design. Only 50 MHz
and 125 MHz are available now. If your board has either of this, uncheck this option,
otherwise, please check this option

Eval PLL Refclk I/O Buffer Type

Specifies the 1/0 buffer type of the PLL reference clock for the LPDDR4 Example Design

Eval PLL Refclk Frequency (MHz)

Specifies the frequency of the PLL reference clock for the LPDDR4 Example Design

Eval Local Bus Clock Frequency
(MHz)

Specifies the frequency of the local AXI4 bus clock for the LPDDR4 Example Design

3.2.5. Bit Swizzle Settings

This section describes the attributes for swapping the DQ bits within the DQS group. This is only shown when you check
the Enable Bit Swizzle attribute. You may use this when swapping the DQ bits will help you improve the routing on the

board.

Please refer to Bit Swizzle section of DDR Memory PHY Module (FPGA-IPUG-02195) for more information about this

feature.
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Table 3.27. LPDDR4 Bit Swizzle Attributes

Attribute Selectable Values ‘ Default | Dependency on Other Attributes
DQSO Bit Swizzle
MC's 0/1/2/3/ o
DQ<00,01,02,03,04,05,06,07> 0,1,23,4,5,6,7 4/5/6/7 If Enable Bit Swizzle is Checked
connects to DRAM DQ
DQSO0 DQ Bit Swizzle Calculated 0x76543210 If Enable Bit Swizzle is Checked
DQS1 Bit Swizzle
MC’s
8/9/10/11

DQ<08,09,10,11,12,13,14,15> 8,9,10,11, 12,13, 14,15 lg/;/lfl/lé If Enable Bit Swizzle is Checked
connects to DRAM DQ
DQS1 DQ Bit Swizzle Calculated 0x76543210 If Enable Bit Swizzle is Checked
DQS2 Bit Swizzle
gloism 1718 19.20.21 22 23> 01234567 0/1/2/3/ If Enable Bit Swizzle is Checked and

R T 4/5/6/7 DDR Bus Width >= 32

connects to DRAM DQ

If Enable Bit Swizzle is Checked and

DQS2 DQ Bit Swizzle Calculated 0x76543210 DDR Bus Width >= 32

DQS3 Bit Swizzle

MC’s
DQ<24,25,26,27,28,29,30,31> 8,9,10,11, 12,13, 14,15
connects to DRAM DQ

8/9/10/11/ If Enable Bit Swizzle is Checked and
12/3/14/15 DDR Bus Width >= 32

If Enable Bit Swizzle is Checked and

DQS3 DQ Bit Swizzle Calculated 0x76543210 DDR Bus Width >= 32

DQS4 Bit Swizzle

MC’s

0/1/2/3 it Swizzle i
DQ<32,33,34,35,36,37,38,39> | 0,1,2,3,4,5,6,7 4;;6;7/ ggg‘;b Ji 55 ;t :’fflzz'f Checked and
connects to DRAM DQ -
DQS4 DQ Bit Swizzle Calculated Ox76543210 | | Enable Bit Swizzle is Checked and

DDR Bus Width == 64

DQS5 Bit Swizzle

MC’s
DQ<40,41,42,43,44,45,46,47> 8,9,10,11,12,13,14,15
connects to DRAM DQ

8/9/10/11/ If Enable Bit Swizzle is Checked and
12/3/14/15 | DDR Bus Width == 64

If Enable Bit Swizzle is Checked and

DQS5 DQ Bit Swizzle Calculated 0x76543210 DDR Bus Width == 64

DQS6 Bit Swizzle

MC’s
DQ<48,49,50,51,52,53,54,55> 0,1,23,4,5,6,7
connects to DRAM DQ

0/1/2/3/ If Enable Bit Swizzle is Checked and
4/5/6/7 DDR Bus Width == 64

If Enable Bit Swizzle is Checked and

DQS6 DQ Bit Swizzle Calculated 0x76543210 DDR Bus Width == 64

DQS7 Bit Swizzle

MC'’s
DQ<56,57,58,59,60,61,62,63> 8,9,10,11,12,13,14,15
connects to DRAM DQ

8/9/10/11/ If Enable Bit Swizzle is Checked and
12/3/14/15 DDR Bus Width == 64

If Enable Bit Swizzle is Checked and

DQS7 DQ Bit Swizzle Calculated 0x76543210 DDR Bus Width == 64
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Table 3.28. LPDDR4 Bit Swizzle Attribute Definitions
Attribute Description
DQS<0,2,4,6> Bit Swizzle!?

Specifies how the DQ bits of the DQS groups 0, 2, 4, and 6 will be connected to the lower
MC’s DQ* connects to DRAM DQ | byte of the LPDDR4 DRAM channel on the board. You can swap around the bits within the
DQS group (DQ byte).

This is the actual parameter used in MC’s RTL. This is calculated based on the DQ connection
settings.

DQS<0,2,4,6> DQ Bit Swizzle

DQS<1,3,5,7> Bit Swizzle'?

Specifies how the DQ bits of the DQS groups 0, 2, 4, and 6 will be connected to the upper
MC’s DQ* connects to DRAM DQ | byte of the LPDDR4 DRAM channel on the board. You can swap around the bits within the
DQS group (DQ byte).

This is the actual parameter used in MC’s RTL. This is calculated based on the DQ connection

DQS<0,2,4,6> DQ Bit Swizzle

settings.
Notes:
1. These DQS group pairs should be connected to the same DRAM channel: (DQSO, DQS1), (DQS2, DQS3), (DQS4, DQS5), and
(DQS6, DQS7)

2. Swapping the DQS group with another DQS group is not yet supported.

The DDRPHY Hard IP’s connection to the I/O is a dedicated path. The Bit Swizzle feature will not affect the pin mapping
in Radiant. This means the following:

e The Radiant Report Browser > Place & Route Reports -> Signal/Pad report will still show the dedicated pin
locations.

e If you want to add the pin assighment constraint (Idc_set_location) in the Radiant project Post-Synthesis
Constraint Files, you should still use the dedicated pin locations.

For consistency, we recommend that your schematic show the swizzled connection for easy cross-checking with the Bit
Swizzle settings in the IP GUI.
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4. Signal Description

The input and output signals of the DDR Memory Controller IP are covered in this section. The signals available are
based on the selected configuration of the Memory Controller IP.

4.1. Clock and Reset

Table 4.1. Clock and Reset Port Definitions

Port Name 1/0 Width Description

PLL reference clock input. It is recommended to use 100 MHz for better
clock performance. Please refer to Design Rules and Guidelines section
of Avant High Speed |0 and External Memory Interface User-Guide
(FPGA-TN-02300) for more information.

PLL reset active low. The minimum reset pulse width is 5 ps.

This will cause pll_lock_o to de-assert and sclk_o to stop. If you assert
pll_rst_n_i In 1 this signal, you should assert the main reset, rst_n_i as well. You can
assert the rst_n_i at the same time as pll_rst_n_i or after pll_rst_n_i de-
asserts.

pll_refclk_i In 1

Clock for APB interface, training CPU and control logic of the internal
PLL. This clock is independent of sclk_o, since sclk_o stops during clock
frequency changes.

Supports 50 MHz to 150MHz in simulation, but the upper limit for
implementation may be less than 150 MHz, depending on the Radiant
timing analysis report.

pclk_i In 1

Asynchronous active low reset for APB interface. This reset must be de-
asserted synchronous to pclk_i.

Clock for AX14 interface.
The fmax is limited by the Radiant timing analysis report.

preset_n_i In 1

aclk_i In 1

System clock. This is % of the DDR clock frequency and is the main clock

sclk_o Out 4 of the Memory Controller IP.

Asynchronous active low reset. When asserted, output ports, including
the AX14 Data Interface and the APB Configuration Interface and
registers are forced to their reset values. The Memory Controller IP
implements logic to de-assert the internal reset synchronous to the
rst_n_i In 1 internal clocks (sclk_o, pclk_i and aclk_i) after rst_n_i de-asserts. After
rst_n_i deassertion, wait for a minimum of 5 pclk_i before accessing the
registers.

If you assert this reset signal, you need to perform the full initialization
and training as described in the Calibration section.

Asynchronous active low reset for AXI4 I/F.
areset_n_i In 1 This reset must be de-asserted synchronous to aclk_i.
This is only available when Enable Local Bus Clock attribute is checked.
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4.2. Interrupts and Initialization/Training

This section describes the interface ports for interrupts and initialization/training control in the Memory Controller IP.

Table 4.2. Interrupts and Initialization/Training Port Definitions

Port Name 1/0 Width Description
irq_o out 1 Interrupt 5|g.nal
Reset value is 1’b0
init start i In 1 Starts the memory initialization and training according to trn_opr_i.
= - This signal is available when Enable APB I/F attribute is unchecked.
. Indicates completion of initialization and training and the memory is
init_done_o Out 1 . .
- - available for access through the data interface.
PLL lock output indicating when PLL is locked.
pll_lock_o Out 1 Do not access the Memory Controller IP in any bus I/F or init_start_i
when the PLL is not locked.
Sets the Training Operation Register (TRN_OP_REG), which specifies the
trn_opr_i in 10 training steps to perform. Refer to the DDR Memory PHY Module (FPGA-
IPUG-02195) for more details.
trn_err_o Out 1 Indicates memory training has failed when asserted (1'b1)

4.3. APB Register Interface

This section describes the configuration interface port when the Enable APB I/F attribute is checked in the Memory
Controller IP. Refer to the AMBA APB Protocol Specification for a description of these signals.

Table 4.3. APB Interface Port Definitions

Port Name 1/0 Width Description
APB Select signal
apb_psel_i In 1 Indicates that the subordinate device is selected, and a data transfer is
required
apb_paddr_i In 12 APB Address signal
. APB Write data signal
apb_pwdata_i In 32 Bits [31:8] are not used
apb_pwrite_i In 1 APB Di.rection signal
- - 1 = Write, 0 = Read
apb_penable_i In 1 API? Enable signal
Indicates the second and subsequent cycles of an APB transfer
APB Ready signal
apb_pready o Out 1 Indicates transfer completion. Subordinates use this signal to extend an
APB transfer. Reset value is 1’b0.
apb_pslverr_o Out 1 AP? Error signal . . -
- - Indicates a transfer failure. This signal is tied to 1’b0.
apb_prdata_o Out 32 APB Read data signal
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4.4. AXl4 Data Interface

This section describes the AXI4 data interface ports in the Memory Controller IP. Refer to the AMBA AXI Protocol
Specification for a description of these signals. The transactions allowed on the AXI4 interface to the Memory
Controller are described in Table 2.2.

Table 4.4. AXI4 Interface Port Definitions

Port Name 1/0 Width Description
axi_arid_i In AXI_ID_WIDTH AXI4 read address channel: Read address ID signal
axi_araddr_i? In AXI_ADDR_WIDTH AXI4 read address channel: Read address signal
AXI14 read address channel: Burst length signal
axi_arlen_i In 8 Supports up to burst length 64 only, it is prohibited to issue more than
this
axi_arsize_i In 3 AXI4 read address channel: Burst size signal
. . AXI14 read address channel: Burst type signal
axi_arburst_| In 2 Only INCR is supported pese
axi_arqos. i In 4 AX.I4 r‘ead zfddress channel: Quality of service signal
This signal is currently unused
axi_arvalid_i In 1 AXI14 read address channel: Read address valid signal
axi_arready_o Out 1 AXIl4 read address channel: Read address ready signal
axi_rid_o Out AXI_ID_WIDTH AXIl4 read data channel: Read ID tag signal
axi_rdata_o* Out AXI_DATA_WIDTH AXIl4 read data channel: Read data signal
axi_rresp_o Out 2 AXI4 read data channel: Read response signal
axi_rlast_o Out 1 AXI4 read data channel: Read last signal
axi_rvalid_o Out 1 AXIl4 read data channel: Read valid signal
axi_rready_i In 1 AXI14 read data channel: Read ready signal
axi_awid_i In AXI_ID_WIDTH AXI14 write address channel: Write address ID signal
axi_awaddr_i*? In AXI_ADDR_WIDTH AXI14 write address channel: Write address signal
axi_awlen_i In 8 AXI14 write address channel: Burst length signal
axi_awsize_i In 3 AXI4 write address channel: Burst size signal
axi_awburst_i In 2 AXI4 write address channel: Burst type signal
axi_awqos_i In 4 AXI4 write address channel: Quality of service signal
axi_awvalid_i In 1 AXI14 write address channel: Write address valid signal
axi_awready_o Out 1 AXI14 write address channel: Write address ready signal
axi_wdata_i* In AXI_DATA_WIDTH AXI4 write data channel: Write data signal
axi_wstrb_i* In AXI_DATA_WIDTH/8 | AXI4 write data channel: Write strobe signal
axi_wlast_i In 1 AXI4 write data channel: Write last signal
axi_wvalid_i In 1 AXI4 write data channel: Write valid signal
axi_wready_o Out 1 AXI4 write data channel: Write ready signal
axi_bid_o Out AXI_ID_WIDTH AXIl4 write response channel: Response ID tag signal
axi_bresp_o Out 2 AXI14 write response channel: Write response signal
axi_bvalid_o Out 1 AXI14 write response channel: Write response valid signal
axi_bready_i In 1 AXI4 write response channel: Response ready signal
Notes:

1. The bit width of axi_araddr_i/axi_rdata_o/axi_awaddr_i/axi_wdata_i/axi_wstrb_i are calculated based on the DDR density and
DDR Bus Width attributes in Table 3.3.

2. Refer to the DDR Memory PHY Module (FPGA-IPUG-02195) for the address mapping.
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4.4.1. AXI4 Address Mapping for DDR4 mode

In DDR4 mode, the Bank Group is mapped within the burst address mapping so that sequential writes and sequential
reads can be executed in the DDR side without gap. This causes the column address bits to split into two, namely,
Column High and Column Low.

Table 4.5. AXI4 Address Mapping for DDR4 mode

== LATTICE

Memory Address Size Local Address Map
If Number of Ranks == 2: RANKW =1 . s .
Rank If Number of Ranks == 1: Not available Local address mapping within each rank remains the same
ROWW = refer to memory device data ROW_H =ROW_L + ROWW -1 )
Row sheet ROW L= BANK H+1 Addr[ROW_H: ROW_L]
BANK_H = BANK_L + BANKW — 1 ,
Bank BANKW =2 BANK L=COL H_H+1 Addr[BANK_H: BANK_L]
. COLH_H = COLH_L + COLHW -1 .
Column High COLHW =7 COLH_L=BG_H+1 Addr[COLH_H: COLH_L]]
BG_H=BG_L+BG L-1 ,
Bank Group BGW =2 BG_L=COLL H+1 Addr[BG_H: BG_L]
COLL_H=COLL_L +COLLW -1 .
Column Low COLLW =3 COLL_L = OFFSET_W Addr[COLL_H: COLL_L]
If DDR Bus Width == 64: OFFSETW =3
Offset If DDR Bus Width == 32: OFFSETW = 2 N/A
If DDR Bus Width == 16: OFFSETW =1

Table 4.6. AXI4 Address Mapping Example for DDR4 mode

Memory Address Example User Value Actual Line Size Local Address Map
Offset DDR Bus Width = 32 2 *addr_i[1:0]
Column Low Width (COLLW) 3 (Fixed for DDR4) 3 *addr_i[4:2]

Bank Group Width (BGW) 2 (Fixed for DDR4) 2 *addr_i[6:5]
Column High Width (COLHW) | 7 (Fixed for DDR4) 7 *addr_i[13:7]

Bank Width (BANKW) 2 (Fixed for DDR4) 2 *addr_i[15:14]
Row Width (ROWW) DDR Density = 4 15 *addr_i[30:16]
Rank Width (RANKW) Number of Ranks = 1 0 --

Total Local Address Line Size 31 *addr_i[30:0]

4.4.2. AXI4 Address Mapping for LPDDR4 mode

Table 4.7. AX14 Address Mapping for LPDDR4 mode

Memory Address Size Local Address Map
If Number of Ranks == 2: RANKW =1 . L .
Rank \f Number of Ranks == 1: RANKW = 0 Local address mapping within each rank remains the same
ROWW = refer to memory device data ROW_H=ROW_L+ROWW -1 .
Row sheet ROW L= BANK_H + 1 Addr[ROW_H: ROW_L]
BANK_H = BANK_L + BANKW — 1 .
Bank BANKW =3 BANK L= COL H+1 Addr[BANK_H: BANK_L]
COL_H=COL_L+COLW -1 .
Column coLw =10 COL_L = OFFSET W Addr[COL_H: COL_L]]
If DDR Bus Width == 64: OFFSETW = 3
Offset If DDR Bus Width == 32: OFFSETW =2 N/A
If DDR Bus Width == 16: OFFSETW =1
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Table 4.8. AXI4 Address Mapping Example for LPDDR4 mode
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Memory Address Example User Value Actual Line Size Local Address Map
Offset DDR Bus Width = 32 2 *addr_i[1:0]
Column Width (COLW) 10 (Fixed for LPDDRA4) 10 *addr_i[11:2]

Bank Width (BANKW) 3 (Fixed for LPDDR4) 3 *addr_i[14:12]
Row Width (ROWW) DDR Density = 4 15 *addr_i[29:15]
Rank Width (RANKW) Number of Ranks = 1 0 -

Total Local Address Line Size 30 *addr_i[29:0]

4.5. Memory Interface Signals

4.5.1. DDR4 Memory Interface
This section describes the interface ports for DDR4 SDRAM.

Table 4.9. DDR4 Interface Port Definitions

Port Name 1/0 Width Description
ddr_ck_o*? Out CK_WIDTH DDR4 CK signal
ddr_cke_o'? Out CK_WIDTH DDR4 CKE signal
ddr_cs_o'? Out CS_WIDTH DDR4 CS signal
ddr_ca_o? Out CA_WIDTH DDR4 CA signal
ddr_we_n_o? Out 1 DDR4 WE signal
ddr_cas_n_o? Out 1 DDR4 CAS signal
ddr_ras_n_o? Out 1 DDR4 RAS signal
ddr_act_n_o? Out 1 DDR4 ACT_n signal
ddr_ba_o? Out BANK_WIDTH DDR4 BA signal
ddr_bg_o? Out BG_WIDTH DDR4 BG signal
ddr_odt_o? Out ODT_WIDTH DDR4 ODT signal
ddr_reset_n_o? Out 1 Memory reset signal
ddr_dq_io! In/Out BUS_WIDTH DDR4 DQ signal
ddr_dgs_io! In/Out DQS_WIDTH DDR4 DQS signal
ddr_dmi_io* In/Out DQS_WIDTH DDR4 DM signal
Notes:

1. The bit width of SDRAM Memory Interface signals is defined based on the attributes listed in Table 3.3.
2. For component, the command, address and control signals should be terminated to VTT on the board. This is not needed for
UDIMM because it already has the termination within UDIMM.

4.5.2. LPDDR4 Memory Interface
This section describes the interface ports for LPDDR4 SDRAM.

Table 4.10. LPDDR4 Interface Port Definitions

Port Name 1/0 Width Description
ddr_ck_o* Out CK_WIDTH LPDDR4 CK signal
ddr_cke_o? Out CK_WIDTH LPDDR4 CKE signal
ddr_cs_o? Out CS_WIDTH LPDDR4 CS signal
ddr_ca_o Out 6 LPDDR4 CA signal
ddr_reset_n_o Out 1 Memory reset signal
ddr_dq_io? In/Out BUS_WIDTH LPDDR4 DQ signal
ddr_dgs_io* In/Out DQS_WIDTH LPDDR4 DQS signal
ddr_dmi_io* In/Out DQS_WIDTH LPDDR4 DMl signal
Note:

1. The bit width of the SDRAM Memory Interface signal is defined based on the attributes listed in Table 3.12.
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5. Register Description

The Memory Controller IP contains user-accessible registers. For a description of these registers, refer to the DDR
Memory PHY Module (FPGA-IPUG-02195).
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6. Memory Controller Example Design

This section describes the Memory Controller Example Design, which you can use for synthesis and simulation after

generating the IP.

6.1. Overview

== LATTICE

Table 6.1 summarizes the IP parameter configurations in the Memory Controller Example Design. To generate the
Memory Controller IP Core, refer to the Designing and Simulating the IP section of this user guide.

Table 6.1. Supported Example Design Configurations

Attribute

Supported Setting

1/0 Buffer Type

All

DDR Command Frequency

All

Enable Power Down

Checked, Unchecked

Enable DBI

Checked, Unchecked

PLL Reference Clock from Pin

Checked, Unchecked

DDR Bus Width 16, 32,64
Local Data Bus Type AXl14

ID Width All
Number of Outstanding Writes/Reads All
Write/Read Ordering Queues All

Enable Local Bus Clock

Checked, Unchecked

Enable APB I/F

Checked, Unchecked

Memory Device Timing Tab?!

All

Training Settings Tab?

All

Note:

1. The DDR Clock Delay Value and Address Control Delay Value are not supported/reflected in Memory Controller Simulation
Example Design. All other configurable attributes are supported in the Memory Controller Example Design.

6.2. Synthesis Example Design

After generating the DDR Memory Controller IP, you can access a synthesizable example design. This design includes a
test program for evaluating the Memory Controller IP on hardware. Figure 6.1 represents a block diagram of the

Memory Controller Example Design.

UART RX/T)&

aclk_i

LED[7:0]

INST 9 > UART |
cPu | SYS_MEM
DATA
pclk_i
2
-
2> AHBL2APB | —
u
<<

|
|
|
|
|
|
|
I
|
|
|
|
|
|
|

KITCAR

Memory

LED[9:8]

DDR4/LPDDR4 I/F

LEGEND
pclk_i domain

Controller (configuration I/F)

pll_refclk_i

aclk_i/sclk_o domain
(datal/F)

sclk_o domain

Figure 6.1. Synthesis Example Design
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The main blocks that make up the synthesizable example design include the following:

e RISC-V CPU subsystem — handles initialization and training of the DDR4/LPDDR4 interface and performs data
access checks.

e System Memory (SYS_MEM) — stores the instruction code for the example design test program.
e AHBL2APB bridge — converts the CPU data interface (AHB-Lite) to the configuration interface (APB).
o  UART block — allows you to interface with the test program and prints out results via a serial terminal connection.

e  GPIO block — allows you to verify the result of the DDR4/LPDDR4 training sequences and the functionality of pclk_i
and aclk_i clock signals.

e Traffic generator block — implements a series of pseudo-random (PRBS) writes and reads, and compares the read
data to the expected data, displaying the result over a UART connection.

e Memory Controller IP — provides an interface to external DDR4/LPDDR4 memory to issue reads and writes.

e  Oscillator (OSC) — generates a 50 MHz clock for the PLL.

e  PLL - takes the oscillator output as an input reference clock to the PLL. The PLL generates both the configuration
interface clock (pclk_i = 100 MHz) and the user data interface AXI clock (aclk_i = 250 MHz).

The synthesizable example design includes a test program stored in system memory, fetched by the CPU instruction
port. The CPU data port accesses system memory and connects to Configuration Set Registers (CSRs), UART, GPIO,
traffic generator, and Memory Controller. The test program associated with the example design performs the following
tasks:

e  Waits for user input over a serial terminal connection upon asserting the reset signal: rstn_i

e  Configures the Memory Controller to perform a complete reset, initialization, and training of the DDR4/LPDDR4
interface.

e |f datarate < 1,333 Mbps : TRN_OP_REG = 0x0DF during training

e If dataratein [1,600 Mbps, 1866Mbps]: TRN_OP_REG = 0x1DF during training

e [f datarate > 2,133 Mbps: TRN_OP_REG = 0x3DF during training
e Performs a series of loop-back data access checks
e (Calculates the performance of the DDR4/LPDDR4 interface
The top-level example design wrapper file, eval_top.sv, provides ports for a PLL reference clock, DDR4/LPDDR4
interface, UART interface, and a 10-bit LED output. LED[7:0] corresponds to bits STATUS_REG[8:1], whereas toggling on
LED[8] indicates aclk_i is functioning and toggling on LED[9] indicates pclk_i is functioning. For information on the
example design test program and instructions on generating and performing hardware evaluation of the Memory
Controller Example Design, refer to the Designing and Simulating the IP section of this user guide.

6.3. Simulation Example Design

The simulation example design is similar to the synthesizable example design, apart from the following changes:
e Disables UART connection

e External DDR4/LPDDR4 memory is replaced with DDR4/LPDDR4 memory model

The UART connection is disabled in simulation since it takes a long time to simulate. The DDR4/LPDDR4 memory model
allows simulation of user-initiated operations to DDR4/LPDDR4 SDRAM. For instructions on simulating the Memory
Controller, including the example design, refer to the Designing and Simulating the IP section of this user guide.
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6.3.1. DDR4

Table 6.2 summarizes the simulation runtime of the DDR4 Memory Controller for various configurations.

Table 6.2. DDR4 Simulation Runtime Summary

DDR4 Configuration Typical Initialization Time Typical Training Time
x32, 1,066 MHz (single rank) 46.014 us 30.753 us
x16, 933 MHz (single rank) 48.289 us 30.853 ps
x32, 933 MHz (single rank) 48.169 us 30.853 us
x64, 933 MHz (single rank) 47.899 us 30.853 ps
x16, 800 MHz (single rank) 50.807 ps 35.475 ps
x32, 666 MHz (single rank) 55.387 us 37.278 us
x64, 666 MHz (single rank) 55.087 s 37.278 ps
x16, 1,066 MHz (dual rank) 46.134 us 60.735 ps

Initialization time is measured from the moment the CPU and Controller Engine are pulled out of reset (RESET_REG) to
the assertion of the DDR4 Clock Enable signal (ddr_cke_o). Training time is measured from the ddr_cke_o assertion to
the assertion of init_done_o, indicating the completion of the initialization and training sequence. For more details on
the initialization and training sequences, refer to the Calibration section of this user guide.

6.3.2. LPDDR4

Table 6.3 summarizes the simulation runtime of the LPDDR4 Memory Controller for various configurations.

Table 6.3. LPDDR4 Simulation Runtime Summary

LPDDR4 Configuration Typical Initialization Time Typical Training Time
x32, 1,066 MHz (single rank) 53.019 ps 102.459 ps
x16, 933 MHz (single rank) 54.281 ps 106.248 s
x32, 933 MHz (single rank) 54.311 ps 106.998 s
x64, 933 MHz (single rank) 54.191 ps 108.468 s
x16, 800 MHz (single rank) 54.981 ps 109.709 us
x32, 666 MHz (single rank) 58.288 us 114.854 us
x64, 533 MHz (single rank) 63.128 us 128.906 us
x16, 1,066 MHz (dual rank) 52.989 ps 162.369 us

Initialization time is measured from the moment the CPU and Controller Engine are pulled out of reset (RESET_REG) to
the assertion of the LPDDR4 Clock Enable signal (ddr_cke_o). Training time is measured from the ddr_cke_o assertion
to the assertion of init_done_o, indicating the completion of the initialization and training sequence. For more details
on the initialization and training sequences, refer to the Calibration section of this user guide.
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7. Designing and Simulating the IP

This section describes the steps required within Lattice Radiant software to configure and generate the DDR Memory
Controller IP. It also provides information on the design implementation and hardware evaluation of the synthesizable
example design. The screenshots provided are for reference only. The details may vary depending on the version of the
IP or software being used.

7.1. Generating the IP

This section describes the steps required to create, configure, and generate an instance of the DDR Memory Controller
IP.

7.1.1. Creating a Radiant Project
In order to generate an instance of the Memory Controller IP, a Lattice Radiant project must first be created.

1. Launch the Lattice Radiant software and select File > New > Project. This action opens the New Project dialog box.
Click Next.

Lattice Radiant Software - Start Page

File Edit View Project Tools Window Help
Mew b4 File. Ctrl+M
Open v [ Project... Ctrl+Shift+N
Add »
Close Ctrl+F4
Close All

Bl save Al Ctrl+Shift+5
Recent Files 3
Recent Projects 3
Exit

Figure 7.1. Creating a New Radiant Project

2. Specify a name (<project_name>) for the Lattice Radiant project, a directory (<project_directory>) to store the
project files, and a top-level design implementation name (<top_level_instance_name>). Click Next twice.
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New Project

Project Name

Enter a name for your project and specify a directory where the project data files will be stored.

Project:

Mame: project_name

Location: | project_directory

Project will be created at project_directory fproject_name

Implementation:

Mame: top_level_instance _name|

Location:  project_directoryfproject_name/top_level_instance_name

< Back Mext =

-

Cancel

Browse...

Create subdirectory

Help

Figure 7.2. New Project Settings

3. Under Family, select Avant. Under Device, Package, Operating Condition, and Performance Grade, make the

appropriate selections representative of the selected device part number. Click Next.

New Project

Select Device
Specify a target device for the project.

Select Device:
Family: Device:

iCEA0UP (iCE40 UltraPlus) = LAV-AT-E30ES

LAV-AT (Avant) LAV-AT-E50
LFCPNX (CertusPro-NX) LAV-AT-E70
LFD2NX (Certus-NX) LAV-AT-E70B

LFMXO5 (MachX05-NX)
LIFCL (CrossLink-NX)

LAV-AT-E70ES1

LN2-CT (Certus-N2) LAV-AT-G50
LN2-MH (Mach-N2) LAV-AT-G70
UT24C (Certus-NX-RT) LAV-AT-G70ES
UT24CP (CertusPro-NX-... LAV-AT-X50
LAV-AT-X70

4 P4
Operating Condition: Package:
Commercial v | LFG1156

Performance Grade:
3
Part Number:

LAV-AT-E70ES1-3LFG1156C

Online Data Sheet for Device

Device Information:
Core Voltage:

System LCs:
LUTs:
Registers:
EBR Blocks:
DDRPHY:
DSPs:
PLLs:

DLLs:
PCSs:

PIO Cells:
PIO Pins:

< Back Next >

0.82V
637000
397440
397440
990

3

1800
1

13

557
557

Cancel

Help

Figure 7.3. Project Device Settings
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4. Specify the desired synthesis tool for the implementation of the Lattice Radiant project. Click Next and Finish.

New Project X
Select Synthesis Tool

Specify a synthesis tool for the implementation.

Synthesis Tools:
® Synplify Pro

Lattice LSE

< Back Next > Cancel Help

Figure 7.4. Project Synthesis Tool Selection

7.1.2. Configuring and Generating the IP
The following steps illustrate how to generate the Memory Controller IP Core in Lattice Radiant software.
1. Under the IP Catalog (Tools > IP Catalog), locate and double-click on the desired Memory Controller IP listed under
IP > Processors_Controllers_and_Peripherals.
a. If no Memory Controller IPs are installed on the system, select the IP on Server tab within the IP Catalog.
b. Click the Download from Lattice IP Server icon next to the desired Memory Controller IP for installation. This
will open an IP License Agreement dialog box.
Click Accept, then click on the Refresh IP Catalog icon.
d. Locate the installed Memory Controller IP under the IP on Local tab within the IP Catalog and double-click.
e |P Core v2.x.x = Memory Controller (DDR4/LPDDR4 mode)

2. The Module/IP Block Wizard dialog box opens. Provide a name (<instance_name>) and directory
(<instance_directory>) for the Memory Controller IP, where the default directory is set to
<project_directory>/<project_name>. Click Next.
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| Medule/IP Block Wizard %
Generate Component from IP ddr_mc Version 2.5.0

This wizard will guide you through the configuration, generation and instantiation of this Module/IP, Enter
the following infermation to get started.

Compenent name:  instance_name

Create in: Ci/project_directory/project_name Browse...

This will automnatically create a folder for instance_name inside the Ci/project_directory/project_name

Mext = Cancel

Figure 7.5. IP Instance Settings

3. The Memory Controller IP editor contains multiple tabs that need to be configured according to the desired
DDR4/LPDDR4 memory interface implementation. The following table provides high-level guidance for configuring
the tabs in the Memory Controller IP editor. For detailed information on the individual attributes, refer to the IP
Parameter Description section of this user guide.

Table 7.1. Memory Controller Attribute Guidelines
Memory Controller IP Attribute Tab Guidelines
DDR4

e  Ensure that the Memory clock frequency (DDR Command Frequency) is entered

correctly.
General

e Refer to the datasheet for the selected DDR4 memory device to ensure the
channel density (DDR Density per Channel) is set correctly.

Refer to the datasheet for the selected DDR4 memory device to modify the default

Device Timi
Memory Device Timing timing parameters as needed.

e  You should perform signal integrity analysis with the system IBIS model, using a
tool such as HyperLynx, to determine the optimal I/0 and ODT settings for custom
boards.

Training Setti
raining Settings e Modify the DDR Clock Delay value only if an error occurs during write leveling.

e  Modify the Address Control Delay value only if an error occurs during command

bus training.
LPDDR4
e  Ensure that the Memory clock frequency (DDR Command Frequency) is entered
correctly.
General

e  Refer to the datasheet for the selected LPDDR4 memory device to ensure the
channel density (DDR Density per Channel) is set correctly.

Refer to the datasheet for the selected LPDDR4 memory device to modify the default
timing parameters as needed.

Memory Device Timing

e You should perform signal integrity analysis with system IBIS model, using a tool
such as HyperLynx, to determine the optimal I/O and ODT settings for custom
boards.

Traini .
raining Settings e  Modify the DDR Clock Delay value only if an error occurs during write leveling.

e  Modify the Address Control Delay value only if an error has occurred during
command bus training.
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4. Click Generate. The Check Generating Result dialog box opens, showing design block messages and results as

shown in Figure 7.6. Click Finish.

2] Module/IP Block Wizard X

Check Generated Result
Check the generated component results in the panel below. Uncheck eption 'Insert to project’ if you de not want to
add this component to your design.

Component 'instance_name' is successfully generated.
IP: ddr_mc  Version: 2.5.0

Vendor: latticesemi.com

Language: Verilog

Generated files:

IP-¥ACT_component: componentxml
IP-XACT_design: designxml
black_box_verilog: rtl/instance_name_bb.v
cfg: instance_name.cfg

dependency file: eval/dut_inst.y
dependency_file: eval/dut_params.v

IP package file: instance_name.ipx
tcl_constraints: constraints/instance_name
template_verilog: misc/instance_name_tmpl.v
dependency_file: testbench/dut_inst.v
dependency_file: testbench/dut_params.v
timing_constraints: constraints/instance_name.ldc
template_vhdl: misc/instance_name_tmpl.vhd
top_level_system_verilog: rtl/instance_name.sv

[ Insert to project

<Back | Finish

Figure 7.6. IP Generation Result

5. All the generated files are placed under the <instance_directory>/<instance_name> directory path. The generated
files in the <instance_directory>/<instance_name> directory are listed in the following table.

Table 7.2. Generated File List

File Name

Description

component.xml

Contains the ipxact:component information of the IP.

design.xml

Lists the set parameters of the IP in IP-XACT 2014 format.

<instance_name>.cfg

Lists only the configured/changed parameter values set during IP configuration.

<instance_name>.ipx

Lists the files associated with IP generation.

constraints/<instance_name>.ldc

Defines the 1/0 standard for DDR4/LPDDR4 memory interface signals.

constraints/constraints.sdc

Pre-Synthesis and Pre-Map constraints for the IP.

eval/apb2init.sv

Implements handshaking between APB accesses and internal RISC-V CPU for initialization
of DDR4/LPDDR4 memory in the Memory Controller Example Design.

eval/assign_pins.py

Add the pin assignment to eval constraint.pdc based on the Select Development Board
settings.

eval/async_reset_sync_deassert.v

Synchronize the reset de-assertion to the rising edge of the clock.

eval/blink_led.v

Drives LEDs on and off to indicate that internal clocks (pclk and aclk_i) are active in the
Memory Controller Example Design.

eval/clock_constraint.sdc

Pre-synthesis constraint for setting the PLL reference clock frequency of the Memory
Controller Example Design.

eval/constraint.pdc

Post-synthesis constraints for the Memory Controller Example Design. When the
attribute Select Development Board is set (not None) in the IP GUI, this file will contain
the pin assignments for the target Lattice board.

eval/dut_inst.v

Instantiation of generated IP core in eval_top.sv for the Memory Controller Example
Design.

eval/dut_params.v

Defines local parameters for eval_top based on parameter values set during IP
configuration for the Memory Controller Example Design.

eval/eval_top.sv

Top-level RTL file for the Memory Controller Example Design.
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File Name

Description

eval/measure_trn.sv

May be used to measure the training time on silicon/board and observe the result via
reveal.

eval/pllo.v

eval/pllo_refclk125.v

PLL responsible for generating APB clock (pclk) and AXI4 (aclk_i) in the Memory
Controller Example Design.

eval/select_protocol.py

Script that defines DDR4/LPDDR4 protocol for eval_top and tb_top files in the Memory
Controller Example Design.

eval/axi_bridge/

Contains RTL for AXI bus interface to Native I/F.

eval/traffic_gen/

Contains RTL files for the Memory Controller Example Design.

misc/<instance_name>_tmpl.v
misc/<instance_name>_tmpl.vhd

These files provide instance templates for the IP core.

rtl/<instance_name>.sv

Example RTL top-level file that instantiates the IP core.

rtl/<instance_name>_bb.v

Example synthesizable RTL black box file that instantiates the IP core.

testbench/debug_c_code.sv

testbench/delay_1dir.sv

testbench/dgs_grp_delay.sv

For internal debugging use only.

testbench/dq_bit_swizzle.vh

Specifies the MC to DRAM connection based on the Bit Swizzle settings.

testbench/dut_inst.v

Template instance files.

testbench/dut_params.v

List of parameters based on user IP configurations.

testbench/tb_top.sv

Top level testbench file.

testbench/ddr4/

testbench/lpddr4/

Contains DDR4/LPDDR4 memory model and instances for simulation.

7.2. Design Implementation

This section outlines the steps to properly run a Memory Controller for Avant IP design on hardware.

7.2.1. Pin Placement

Typically, all external memory interfaces require the following FPGA resources:

e Data, data mask, and data strobe signals
e Command, address, and control signals

e  PLL and clock network signals

e RZQsignals
e  Other FPGA resources

In Lattice Avant FPGA devices, the DDRPHY supports external memory interfaces. Each DDRPHY consists of three High
Performance 1/O (HPIO) banks, labeled as HIGHSPEED in the device pinout tables. Since Avant leverages a hardened
PHY, the external memory interface pinouts are in fixed locations. Each pin location is specified under DDRPHY in the
device pinout tables. Dedicated clock routing within HPIO banks is represented as PLL or PCLK, and dedicated reference
voltage pins are represented as VREF in the device pinout tables. Refer to the Avant High-Speed I/O and External
Memory Interface User Guide (FPGA-TN-02300) and Pinout files located on the Avant-E, Avant-G, and Avant-X web

pages.

Observe the following guidelines when placing pins for external memory interfaces:
e Ensure that pins for external memory interfaces reside within a DDRPHY.

e You must assign the input reference clock to the PLL must to use dedicated clock routing (PLL or PCLK). It is
strongly recommended to place the input reference clock on the pin closest to the dedicated PLL within each
DDRPHY (labeled as PLL under DDRPHY in device pinout tables). This ensures better performance by minimizing

jitter/routing.

Always test proposed pinouts in Lattice Radiant software with the correct I/O standards before finalizing. Note that
unused pins within a DDRPHY can be used as general-purpose 1/0 under certain conditions. Refer to the Avant High-
Speed I/0 and External Memory Interface User Guide (FPGA-TN-02300) for more details.
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To ensure proper design coverage and hardware functionality, you must include the following necessary constraints in
their Memory Controller for the Avant IP project.

Table 7.3. Project Constraints

File Name

Description

Action Required

Memory Controller IP LDC file:
constraints/<instance_name>.ldc

Sets the I/0O type for each of the ports
necessary to interface with the
DDR4/LPDDR4 SDRAM

No. These constraints are automatically
propagated

Memory Controller IP SDC file:
constraints/constraints.sdc

Pre-synthesis and pre-map IP timing
constraints

No. These constraints are automatically
propagated

Clock Constraint SDC file:
eval/clock_constraint.sdc

Contains an example constraint for the
input PLL reference clock

Yes — you need to include a create_clock
constraint based on the frequency of the
input PLL reference clock. This should be
placed in a user-created SDC file

Example Design PDC file:
eval/constraint.pdc

Contains generated clock uncertainty
constraints and example design
constraints based on IP configuration

Yes — you need to copy the clock uncertainty
constraints listed in this file directly into your
top-level PDC file. You need to copy the
example design constraints to run the
LPDDR4/DDR4 memory Controller Example
Design

The Memory Controller IP constraints do not define the input and output delay on the DDR 1/O since the routing from
the DDRPHY primitive to/from the I/O is a dedicated path. Additionally, the Memory Controller calibration sequence
compensates for the controller to DRAM end-to-end skew, making it unnecessary to specify I/O timing constraints by

design.

7.2.2.1. Reference Clock SDC

The provided clock_constraint.sdc file contains a single create_clock constraint for the PLL reference clock (pll_refclk_i).
This constraint is necessary for the PLL to generate the constraint for its output clock. You should copy this constraint
into the Radiant Project SDC file (not in PDC file) to allow the synthesis tool to optimize the logic for the target clock.

7.2.2.2. Example Design PDC

The provided constraint.pdc file contains two or three sets of constraints:

e  Clock Uncertainty — defines the clock name for sclk_o and specifies its clock uncertainty based on the measured

clock jitter during HW validation.
e  Eval constraints — specific to the Memory Controller Example Design.

e  Pinouts — specifies the pin assignment for the selected board in the Select Development Board attribute.
This is only available for LPDDR4, Avant-E/G/X70 devices, and the Select Development Board attribute is not set to

None.

If you implement your own Memory Controller design, you need to copy the clock uncertainty constraints into the top-

level user PDC file.

The eval constraints composed of set_false_path, set_max_delay, and |dc_create_group constraints, should only be
copied if running the provided Memory Controller Example Design. Eval constraints are located below the following
comment in the provided constraint.pdc file:

HAHHHHHHHAHH A HH R R R R
# Below are the constraints for eval design, you dont need these if you are not using

the eval

Refer to the Lattice Radiant Timing Constraints Methodology (FPGA-AN-02059) for details regarding the

implementation of constraints.
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7.3. Example Design Hardware Evaluation

After successfully configuring and generating the Memory Controller IP Core, you can use the included synthesis
example design for hardware evaluation of the Memory Controller. For a detailed description of the Memory Controller
Example Design, refer to the Synthesis Example Design section of this user guide. The traffic generator file set is located
under the eval/traffic_gen directory and is described in the Table 7.4.

Table 7.4. Contents of eval/traffic_gen

File List Description

ahbl0.v AHBL_1x2. It routes CPU data access to SYS_MEM or AHBL2APB

ahbl2apb0.v AHBL to APB bridge

apb0.v APB_1x4. It routes CPU data access via AHBL2APB going to each module’s CSR
cpuO.v RISC-V CPU

gpio0.v GPIO module

ctrl_fifo.v

Iscc_axi4_traffic_gen.sv

Iscc_axi4_m_csr.sv

Iscc_axi4_m_rd.sv

Iscc_axi4_m_wr.sv

Iscc_axi4_perf_calc.sv

Iscc_Ifsr.v

mc_axi4_traffic_gen.v

RTL files for AXI4 traffic generator

Iscc_osc.v

oscO.v

RTL files for OSC module

Iscc_ram_dp_true.v

Copy of Lattice Radiant RAM_DP_True Foundational IP (needed by SYS_MEM)

memc_apb.v

RTL file for APB configuration interface

sysmem0Q.v

The SYS_MEM for hardware validation, enabled when eval_top.SIM=0 (Implementation)

uart0.v

The UART module

7.3.1. Preparing the Bitstream

After configuring and generating the Memory Controller IP Core, all associated example design files are created under
the eval directory. Refer to Table 7.2 for more details. The following steps illustrate how to prepare the Memory
Controller Example Design project and generate the associated bitstream.

1. After generating the Memory Controller IP Core, the Radiant project should contain <instance_name>.ipx under
the project’s input files. If not, right-click on Input Files and select Add > Existing File under the File List tab in the
lower-left corner of the Radiant window. This action opens the Add Existing File dialog box. Navigate to the
<instance_directory>/<instance_name> directory and select the <instance_name>.ipx file. Ensure the Copy file to
directory option is unchecked. Click Add.

2. To add the top-level example design file to the project, right-click on Input Files and select Add > Existing File. This
action opens the Add Existing File dialog box. Navigate to the eval directory and select the eval_top.sv file. Ensure
the Copy file to directory option is unchecked. Click Add.
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Add Existing File ? *
Look in: C:\project_directory'project_name\jnstance_name - Q@ ) @ E/ﬁ @ E]
h My Computer Name “ Size Type Date Modified
= dabdulra constraints Fil...der 5/23/2...:47 PM
i
eval Fil...der &/19/2...:56 PM
rmisc Fil..der 6/19/2...:36 PM
rtl Fil...der &/19/2...:56 PM
testbench Fil...der 6/19/2...:56 PM
[ instance_name.ipx 5.45KiB ipx File 6/19/2..:56 PM
File name:
Files of type: | Input Files (*.vhd *.v *.sv *.h *.ipx *.sbx *.vm *.ipm ) = Cancel
Copy file to directory | C:/fproject_directoryproject_name/source ftop_level_instance_name

Figure 7.7. Add Existing File Dialog Box

To add the pre-synthesis constraint file to the project, right-click on Pre-Synthesis Constraint Files and select Add >
Existing File. In the Add Existing File dialog box, check the Copy file to directory option. This ensures any user
modifications are not overwritten when the Memory Controller IP Core is regenerated. Navigate to the eval
directory and select the clock_constraint.sdc file. Click Add.

To add the post-synthesis constraint file to the project, right-click on Post-Synthesis Constraint Files and select Add
> Existing File. In the Add Existing File dialog box, check the Copy file to directory option. Navigate to the eval
directory and select the constraint.pdc file. Click Add.

Modify the constraint.pdc to add the pin assignment for the Avant-E/G/X board. You can do this by either
modifying the constraint.pdc file directly or first synthesizing the Radiant project by clicking on the

SyntheszeDesin | hytton and then adding pinouts via the Device Constraint Editor under Tools > Device Constraint
Editor. Note that when assigning the UART pins, the UART TX signal connects to the UART RX on the FPGA side, and
the UART RX signal connects to the UART TX signal on the FPGA side.
You can skip this step when implementing the LPDDR4 Example design to a Lattice board and the board is chosen in
the Select Development Board attribute in IP GUI.

Before running the example design on hardware, you need to generate a bitstream. You can do this by clicking on

the P button. This will generate a <project_name>_<top_level_instance_name>.bit file under the
<project_directory>/<project_name>/<top_level_instance_name> directory specified in Step 2 of the Configuring
and Generating the IP section of this user guide.

Sometimes you may encounter timing failures during Place and Route due to unconstrained paths specific to their
design. For details on implementing constraints, refer to the Constraints section of this user guide.

7.3.2. Running on Hardware

To perform a hardware evaluation of the Memory Controller Example Design, the following are needed:

Avant-E/G/X FPGA board with UART connection

Associated power supply and programming cable

Personal computer running Lattice Radiant software 2024.1 or later

Lattice Propel™ software 1.0 or later, or any terminal that supports serial communication
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To run the example design on hardware, you need a bitstream file. To generate the .bit file, refer to the Preparing the

Bitstream section of this user guide. The following steps illustrate how to program the FPGA board with the example
design.

1. Connect the FPGA board to the computer and power on the board.

2. Runthe Lattice Radiant Programmer by clicking the ¥ button. This launches the Lattice Radiant Programmer,
which scans for devices and configures the programmer automatically.

£ Radiant Programmer - impl_lxcf * - ] ®
File Edit View FRun Tools Help

IR ] X

Enable Status Device Family Device Operation File Name File Date/Time Cable Setup 8 X
1 LAV-AT LAV-AT-X70 Fast Configuration Cable Settings
Detect Cable
Cable: HW-USBN-28 (FTDI)
< > Port: FTUSB-0 v
Custom port:

Programming Speed Settings

(O use default Clock Divider

TCK ® Use custom Clock Divider
HOST: ™S TCK Divider Setting (0-30): [10 3]
PCICOMPUTER wder Seting (0-202)
FTDIUSB HOST BUILD-IN *
\.
DOWNLOAD CABLE TOK THS 1/0 Settings

CPUMICROPROCE SS0R

(® Use default 1/O settings
TDI LAVAT-XT0

701 00 () Use custom 1/0 settings
RESET TTAG_EN INITN pin connected
DONE pin connected
TRST pin connected
Set TRST high
Set TRST low v
< >
Output 8 x

Lattice VM Drivers detected (HW-DLN-3C (Parallel))
Programmer device database loaded

Output  Td Consale

Figure 7.8. Radiant Programmer

3. Click under the File Name field, and then click on ... to the right of the field to launch the Open File dialog box.

Navigate to the bitstream file generated in Step 6 of the Preparing the Bitstream section of this user guide and click

Open.
e To run the example design, you need to launch a serial terminal. If you wish to use your own serial
communication terminal, skip to Step 6. If you wish to use the Lattice Propel terminal, continue with Step 4.

4. Launch the Lattice Propel software and select Launch. This action opens the default workspace.

To open the terminal, click on the g putton.

Configure the terminal settings to be a Serial Terminal with the appropriate Baud rate, Data size, Parity, Stop bits,
and Encoding. Click OK to launch the Terminal pane at the bottom of the Propel window. Note that the Serial port

will vary depending on the computer setup.
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£ Launch Terminal O X

Choose terminal: |Serial Terminal o
Settings
Serial port: | COM4 ~
Baud rate: | 115200 ~
Data size: |8 v
Parity: None ~
Stop bits: |1 ~
Enceding: | Default (150-2859-1) w

@ Cancel

Figure 7.9. Serial Terminal Settings

7. Program the Lattice FPGA device by clicking the  button. Upon successful programming, assert the rstn_i signal
to run the example design, resulting in the following prompt appearing in the terminal.

e If no message is received, close the current serial terminal, click Detect Cable in the programmer window, and
repeat steps 3—7 in the Running on Hardware section of this user guide with a different Serial port.

Select Test to Run (press corresponding key)

@ = Print Memory Training Stages and Data Access Pattern Definition
1 = Run Memory Training and Data Access Check

2 = Run Memory Training and Data Access In a loop With Reset

Pressing O prints a series of definitions correlating to the memory training and data access test pattern:

A sequence of letters will print out to indicate which training stages were successfully
completed.

I = Initialization

C = Command Bus Training

L = Write Leveling

R = Read Training

W = Write Training

S = SCL Training

B = Bit-Level Trim Sweep Training

A sequence of number will print out to indicate which data access patterns were
successful.

@ = INCR2: 2-beat incrementing burst write followed by 10 burst reads with no delay
between transactions

1 = INCR2: 2-beat incrementing 10 burst writes followed by 10 burst reads with no delay
between transactions
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2 = INCR4: 4-beat incrementing burst write followed by 10 burst reads with no delay
between transactions

3 = INCR4: 4-beat incrementing 10 burst writes followed by 10 burst reads with no delay
between transactions

4 = INCR8: 8-beat incrementing burst write followed by burst read with no delay between
transactions

5 = INCR8: 8-beat incrementing burst write followed by a delay before issuing burst read
6 = INCR64: 64-beat incrementing burst write followed by burst read with no delay
between transactions

7 = INCR128: 128-beat incrementing burst write followed by burst read with no delay
between transactions

8 = INCR256: 256-beat incrementing burst write followed by burst read with no delay
between transactions

p = INCR64 Performance Test: 64-beat incrementing parallel burst write and burst read
with no delay between transactions

Pressing 1 starts the training sequence, followed by 7-9 (based on Maximum Burst Length) different data access checks:

RESULT: Training passed with STATUS_REG_ADDR value: ©x3007F
VREF has been trained to the following values:
MC DQS Grp Vref [DQSO -> DQS3] : 45,45,47,41

The Performance Test measures the throughput of the MC and calculates efficiency via the
calculation:
Total number of wr_rd transactions / Duration of the MC clock (sclk)

BUS EFFICIENCY in %: 80

Performance in Mbps : 55482

Ran : 20000 transactions across sequential address
RESULT : All transaction types have PASSED.
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The bus efficiency value represents the efficiency percentage of the DDR4/LPDDR4 bus utilization, while the
performance value represents the bandwidth of the DDR4/LPDDR4 interface. The following formulas are used to
calculate efficiency and bandwidth:

Efficiency = (Total number of bytes transferred) / (number of DDR clock cycles x (DDR_WIDTH / 8) x gearing ratio)
Bandwidth = (Total number of bytes transferred) / (number of DDR clock cycles x DDR clock period)

The bandwidth can also be calculated using the following equation: DDR4/LPDDR4 Data Width x DDR4/LPDDR4 Data
Rate x (DDR4/LPDDR4 Bus Efficiency / 100), where the DDR4/LPDDR4 Data Rate is in Mbps.

Pressing 2 performs the Test 1 mentioned above, followed by a reset input to the DDR MC, it will repeat many times as
specified in the input prompt. In the example below, Test 1 will be repeated 100 times.

Enter Number of Iterations: 100

If a failure occurs during training, a message is sent over the serial connection notifying you of the particular stage that
has failed. This also aborts the loop-back data access checks.

Command Bus Training Failed

7.4. Example Design Simulation

After successfully configuring and generating the Memory Controller IP Core, you can use the included example design
to simulate the Memory Controller. All associated simulation files are located in the testbench directory. Refer to
Table 7.2 for more details.

The following steps illustrate how to prepare the Memory Controller Example Design project for simulation.

1. Before simulating the example design, complete steps 1-2 under the Preparing the Bitstream section of this user
guide. To add the top-level testbench file to the project, select File > Add > Existing Simulation File. This action
opens the Add Existing Simulation File dialog box. Navigate to the testbench directory and select the tb_top.sv file.
In the Add Existing File dialog box, ensure that the Copy file to directory option is unchecked. Click Add.

2. Before creating the simulation environment, set the SIM parameter in eval_top.sv to 1 and uncomment the
RTL_SIM macro definition in tb_top.sv. These parameters and macro shortens the initialization sequence of the
DDR4/LPDDR4 interface and disables the UART interface for simulation. Do not modify the SIM parameter for
hardware implementation.

When you enable the macro, it programs 0x01C to the Training Operation Register (TRN_OP_REG) to speed up the
simulation runtime by reducing the reset and CKE initialization times.

Note that the memory model in the example design simulation requires a minimum simulation timescale of 1 ps, as
defined by the memory manufacturer. To ensure proper functionality, generate the PLL reference clock with a
minimum timescale of 1 ps. We recommended skipping the training sequences (including command-bus training) by
writing 8’h1C to TRN_OP_REG/trn_opr_i. This will reduce simulation time by programming the verified trained values
into the PHY. Refer to the Simulation Example Design section of this user guide for more details.

www.latticesemi.com/legal


http://www.latticesemi.com/legal

DDR Memory Controller IP Core ::LATTICE

User Guide

To create the simulation environment to simulate the Memory Controller Example Design, the following steps should

be taken:

1. Launch the simulation wizard in Radiant by selecting Tools > Simulation Wizard. This action opens the Simulation
Wizard dialog box. Click Next and provide a name (<sim_name>) and directory (<sim_directory>) for the simulation
project, where the default directory is set to <project_directory>/<project_name>. Click Next.

Simulation Wizard hed

Simulator Project Name and Stage
Enter name and directory for your simulation project. Choose simulator and the process stage you
wish to simul lable stages are automatically displayed.

Project

Project name: 5im7name|

Project location: | C:/project_directory/project_name Browse...
Simulator

® Questasim

QuestaSim Qrun
Invoke

Process Stage
@ RTL

< Back Next > Cancel

Figure 7.10. Simulation Wizard

2. Inthe Add and Reorder Source window, notice that the Source Files only contain the top-level evaluation
(eval_top.sv) and top-level testbench (tb_top.sv) files. Click Next.

Simulation Wizard x

Add and Reorder Source
Add HDL type source files and place test bench files under the design files.

Source Files: d g U \; ry

C:/project_directory/project_name/instance_name/rtl/instance_name.sv
C:/project_directory/project_name/instance_name/eval/eval_top.sv

C:/project_directory/project_name/instance_name/testbench/th_top.sv

Automatically set simulation compilation file order.
Uncheck this if you want to follow the file order from "Input Files" on File List.

< Back Next = Cancel

Figure 7.11. Adding and Reordering Simulation Source Files
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3. Inthe Parse HDL files for simulation window, notice that the Simulation Top Module is set to eval_top. Click Next.

Simulation Wizard

Parse HDL files for simulation
Parse HDL files for simulation.

Simulation top parsing finished.

- Analyzing VHOL file 'C:/lscc/radiant/2024.1ispfpoa/vhdl_packages/mixed_lang_vitype.vhd' (VHDL-1481) s
- Analyzing VHOL file C:flscc/radiant/2024.1fispfpga/vhdl_packages/mixed_lang_vitype.vhd

- Analyzing VHOL file 'C:/lscc/radiant/2024.1/ispfpoajvhdl_packages/syn_arit.vhd’ {VHDL-1481)

- Analyzing VHOL file C:flscc/radiant/2024.1fispfpga/vhdl_packages/syn_arit.vhd

- Analyzing VHOL file 'C:/lscc/radiant/2024.1ispfpoajvhdl_packages/syn_sign.vhd" (VHDL-1481)

- Analyzing VHOL file C:flscc/radiant/2024.1fispfpga/vhd|_packages/syn_sign.vhd

- Analyzing VHOL file 'C:/lscc/radiant/2024.1ispfpoajvhdl_packages/syn_unsi.vhd' (VHDL-1481)

- Analyzing VHOL file C:/lsce/radiant/2024.1fispfpga/vhdl_packages/syn_unsi.vhd

- Analyzing VHDL file 'C:/lscc/radiant/2024. 1/ispfpoa/vhdl_packages/synattr.vhd' (VHDL-1481)

- Analyzing VHDL file C:/lsco/radiant/2024.1fispfpga/vhdl_packages/synattr.vhd

- Analyzing Verilog file 'C:/lsco/radiant/2024. 1/cae_library/synthesis/verilog/lav-abe-es.v' (VERI-1482)

- Analyzing VHDL file 'C:/lscc/radiant/2024.1/cae_library/synthesis/vhdl/lav-ate-es.vhd' (VHDL-1481)

- Analyzing VHDL file C:/lsco/radiant/2024. 1 cae_library/synthesis/vhdl/lav-ate-es.vhd

- Analyzing Verilog file 'C:/project_directory/project_name/instance_name/rtl/instance_name.sv' (VERI-1482)
- Analyzing Verilog file 'C:/project_directory/project_namefinstance_name/eval/eval_top.sv' (VERI-1452)

-- Analyzing Verilog file 'C:/project_directory/project_name/instance_name/testbench/tb_top.sv' (VERI-1482)

Hdl files parsing messages are saved at: C:/project_directory/project_name/sim_namefhdlparser.log

Simulation Top Module: | th_top A

< Back Next > Cancel

Figure 7.12. Parsing Simulation HDL Files

The following error message is expected during the parsing of the HDL files using the Simulation Wizard. These
messages are due to the DDR4 simulation models being encrypted and will not affect the simulation behavior since
Questasim is able to decrypt the DDR4 memory model.

ERROR <1009990> - key_keyowners are not support. Must have "Lattice Semiconductor".

4. This action opens the Summary window. By default, the simulation runs for 100 us, allowing you to configure the
waveform to log signals of interest in the QuestaSim simulator before continuing. You can then enter the following
TCL command in QuestaSim to run the simulation until completion: run -all. Alternatively, if you want to run the
simulation with the default top-level signals, change the 100 ps value to 0 us to execute the simulation completely.

Simulation Wizard

Summary

Simulator : QuestaSim Crun

Project Name : sim_name

Project Location : C:/project_directory/project_name

Simulation Stage : RTL

Simulation Files :
C/project_directory/project_name/instance_name/rtl/instance_name.sv
C:/project_directory/project_name/instance_name/eval/eval_top.sv
Ci/project_directory/project_name/instance_name/testbench/tb_top.sv

Simulation Libraries :

-
Launch Simulator GUI
Design Optimization - Full Debug Add top-level signals to waveform display
Run simulation
Default Run 100.000 | |ns = (0 means ‘run -all}
Simulator Resolution | default ~
< Back Finish Cancel

Figure 7.13. Simulation Summary
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The results of the Memory Controller IP simulation design are shown in Figure 7.14.
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Figure 7.14. Simulation Result Waveform

The following error messages are expected in the QuestaSim simulation log and should be disregarded. These
messages are due to the violation of timing requirements regarding the DDR4/LPDDR4 simulation model as a
consequence of shortening the reset and CKE ini=tialization:

# tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected> 26083125000 : #i## 1lpddr4_debug
RESET_n high input

# tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected> 26083125000 : #it# lpddr4_debug
RESET_n high input

# Error: tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected>.<protected> 26083125000 tINIT1
Error.

# Error: tb_top.LP4MEM_00.mem_x16 00.ins_1ch.<protected>.<protected> 26083125000 tINIT1
Error.

# tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected> 32804075000 : ### 1pddr4_debug CKE
high input

# tb_top.LP4MEM_©@1.mem_x16_01.ins_1ch.<protected> 32804075000 : ### lpddr4_debug CKE
high input

# Error: tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected>.<protected> 32804075000 tINIT3
Error.

# Error: tb_top.LP4MEM_00.mem_x16 00.ins_1ch.<protected>.<protected> 32804075000 +tINIT3
Error.
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Appendix A. Resource Utilization

The following table shows the configuration and resource utilization for LAV-AT-E70ES1-3LFG1156C using Synplify Pro
of Lattice Radiant software 2025.2.

Table A.1.DDR4 Resource Utilization for IP Core v2.7.0

i 1
Configuration ac':(“-n':z';'ax sc"‘(-;::;ax Registers | LUT4Logic | EBR DSP
DDR Command Frequency = 1066, 334.225 300.120 7196 6160 25 0
Others = Default
DDR Command Frequency = 1066,
DDR Bus Width =16, 332.336 300.120 5719 5778 21 0
Others = Default
DDR Command Frequency = 1066,
DDR Bus Width = 64, 296.472 300.120 10,222 7064 33 0
Others = Default

Note:

1. The sclk_o Fmax is generated using the top-level example design wrapper file, eval_top.sv, that is described in the Synthesis

Example Design section of this user guide. These values may increase when the IP Core is used with the user logic.

Table A.2.LPDDR4 Resource Utilization for IP Core v2.7.0

. . aclk_i Fmax sclk_o Fmax* . .
Configuration (MH2) (MHz) Registers LUT4 Logic EBR DSP
DDR Command Frequency = 1066, 325.098 300.120 8098 6677 25 0
Others = Default
DDR Command Frequency = 1066,
DDR Bus Width =16, 335.909 300.120 6538 6103 21 0
Others = Default
DDR Command Frequency = 1066,
DDR Bus Width = 64, 310.174 300.120 11244 7675 33 0
Others = Default

Note:

1. The sclk_o Fmax is generated using the top-level example design wrapper file, eval_top.sv, that is described in the Synthesis

Example Design section of this user guide. These values may increase when the IP Core is used with the user logic.
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Appendix B. Known Issues

1.

LPDDR4/DDR4 with Dual Rank configuration may encounter simulation failures when switching between RO and R1.
This issue will be fixed in future releases.

Enabling the power down feature is known to cause hardware failures. This issue will be fixed in future releases.
Achieving timing closure is difficult when using the DDR Memory Controller IP Core with each speed grade’s
maximum supported interface speed on DDR4.

Some DQ swizzle settings on DQS group 1 may encounter a CBT error due to the initialization values of the DDRPHY
Hard IP’s input DQ, making it appear that the CBT pattern is already matching at the very start of CBT. This issue will
only occur in simulation and will not occur on hardware, since the real default input DQ value in silicon will be zero,
due to the DQ signal being in a high-impedance state, and the termination pulling it down to zero. The simulation
model issue occurs when using Lattice Radiant 2025.2 or earlier.
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For more information refer to:

e DDR Memory Controller IP Release Notes (FPGA-RN-02033)

e DDR Memory Controller Driver (FPGA-TN-02379)

e DDR Memory PHY Module (FPGA-IPUG-02195)
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e Llattice Propel 2024.1 Builder User Guide (FPGA-UG-02212)
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e Lattice Radiant FPGA design software

e Lattice Insights for Lattice Semiconductor training courses and learning plans
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.

For frequently asked questions, please refer to the Lattice Answer Database at
www.latticesemi.com/Support/AnswerDatabase.
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Revision History

Note: In some instances, the IP may be updated without changes to the user guide. The user guide may reflect an
earlier IP version but remains fully compatible with the later IP version. Refer to the IP Release Notes for the latest
updates.

Revision 1.8, IP v2.7.0, December 2025

Section Change Summary
All Updated IP version from 2.6.1 to 2.7.0.
Introduction e  Updated Table 1.1. Quick Facts.

e Added notes 1 and 2.
e Added Driver Support.
e Added Bit Swizzle in the LPDDR4 features section.

e Added Bit Swizzle and 2-D Vref Training in Table 1.3. DDR4 Features Overview and Table
1.4. LPDDR4 Features Overview.

e  Reworked the Licensing and Ordering Information section.

Functional Description . Updated the Clocking and Reset section.
e  Minor updates at the end of AXI4 Data Interface and APB Configuration Interface
sections.

e  Updated the steps to start the initialization and training sequence of the SDRAM device
in the Calibration section.

e  Updated the Initialization and Training without APB Interface section.

e Minor updates added in Temperature Tracking and Extended Temperature Support
section.

IP Parameter Description e  Added Enable Bit Swizzle attribute in Table 3.13. LPDDR4 General Attributes and Table
3.17. LPDDR4 General Definitions.

e Table 3.21. LPDDR4 Training Settings Attributes.
e  Updated the DDR Clock Delay Value.
e  Updated the Address Control Delay Value Incr/Decr to Unchecked.

e  Updated the Eval Local Bus Clock Frequency (MHz) attribute in Table 3.25. LPDDR4

Example Design Attributes and Table 3.26. LPDDR4 Example Design Attribute
Definitions.

e  Added Bit Swizzle Settings section.

Signal Description e Updated description of pll_refclk_i, pll_rst_n_i, and rst_n_i signals in Table 4.1. Clock
and Reset Port Definitions.

e  Updated description of pll_lock_o signal in Table 4.2. Interrupts and
Initialization/Training Port Definitions.

Memory Controller Example e  Updated the Synthesis Example Design section.
Design e  Updated data rate from < 1,866 Mbps to < 1,333 Mbps.

e Added a bullet stating, If data rate in [1,600 Mbps, 1866Mbps]: TRN_OP_REG =
Ox1DF during training.

Designing and Simulating the IP e  Updated Table 7.2. Generated File List to add the new generated files.
e  Updated the Example Design Simulation section.
e  Reworked Step no. 2 on how to prepare the Memory Controller Example Design
project for simulation.
e Updated the 3rd paragraph.
e  Replaced set SIM to 1 to enable the macro.

e  Removed, You can configure the simulation of reset and the initialization and
training sequences by forcing the value of TRN_OP_REG by locating the
following line in tb_top.sv: force
‘DUT_INST_NAME.Iscc_mc_avant_inst.u_ddrphy.i_csr.trn_operation_reg =
10'h01¢C;

Appendix A. Resource Utilization Updated the values in Table A.1.DDR4 Resource Utilization for IP Core v2.7.0 and Table
A.2.LPDDR4 Resource Utilization for IP Core v2.7.0.

Appendix B. Known Issues Added a known issue simulation issue with DQ Swizzle settings on DQS Group 1.
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Section

Change Summary

References

Added the Avant High Speed IO and External Memory Interface User-Guide (FPGA-TN-
02300) in this section.

Revision history

Added a note, In some instances, the IP may be updated without changes to the user guide.
The user guide may reflect an earlier IP version but remains fully compatible with the later IP
version. Refer to the IP Release Notes for the latest updates to this section.

Revision 1.7, IP v2.6.1, October 2025

Section

Change Summary

All

Updated IP version from 2.6.0to 2.6.1.

Introduction

Added note for limitation on support in Table 1.2.

Functional Description

e  Updated TRN_OP_REG value in Calibration section.
e  Updated trn_opr_i value in Initialization and Training without APB Interface section.

IP Parameter Description

Updated DDR Clock Delay Value in LPDDR4 Training Settings section.

Memory Controller Example
Design

e  Updated TRN_OP_REG value in Synthesis Example Design section.

Revision 1.6, IP v2.6.0, June 2025

Section

Change Summary

All

e Minor editorial fixes.
e  Updated IP version from 2.5.2 to 2.6.0.

Introduction

e  Updated Supported Devices and removed Target Devices in Table 1.1.
e Updated DDR4 Features:
e  Removed read DBI
e  Added component (DRAM soldered on the board) and UDIMM support.
e  Added note on dual rank support
e  Updated LPDDR4 Feature: Added note on dual rank support
e  Updated Table 1.3.
o Updated Key Feature Device Format to Component, UDIMM.
e  Updated VREF Training to Not yet supported.

IP Parameter Description

e  Updated Read Latency options and default values in Table 3.1.

e  Updated I/O Buffer Type, Read Latency and Write Latency description in Table 3.5.

e  Updated Slew Rate settings default value in Table 3.10 and Table 3.22.

e Added training settings attributes in Table 3.9, Table 3.12, Table 3.21, and Table 3.24.
e  Updated RTT_WR Value default value in Table 3.11.

e  Updated the DDR Clock Delay default value from 4 to 2 in Table 3.21.

Signal Description

e Updated descriptions of pll_refclk_i, pclk_i, aclk_i, rst_n_i in Table 4.1.
. Removed DDR4 in table label for Table 4.1, Table 4.2, Table 4.3, and Table 4.4.
e Added note 2 in Table 4.9.

Appendix B

e  Added a known issue for dual rank.

Revision 1.5, IP v2.5.2, March 2025

Section

Change Summary

All

e Minor editorial fixes.
e Updated IP version from 2.4.0 to 2.5.2.

Introduction

Updated the Targeted Devices in Table 1.1. Quick Facts.

Functional Description

e  Updated the AXI Data Interface section.
e  Modified the AXADDR description.
e  Added WSTRB description.
e  Updated the recommended value for TRN_OP_REG/trn_opr_i in the Calibration section.
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Section

Change Summary

IP Parameter Description

Added Pull-Down Drive Strength in the LPDDR4 Training Settings section, Table 3.23 and
Table 3.24.

Added the Example Design section under LPDDRA4.

Signal Description

Unified the following sections for both DDR4 and LPDDRA4.
e  Clock and Reset

e Interrupts and Initialization/Training

e  APB Register Interface

e  AXl4 Data Interface

Updated the width of trn_opr_i in Table 4.2. DDR4 Interrupts and Initialization/Training
Port Definitions.

Added the following subsections under AXI Data Interface section:
e  AXI4 Address Mapping for DDR4 mode
e  AXI4 Address Mapping for LPDDR4 mode

Memory Controller Example
Design

Updated the TRN_OP_REG value in the Synthesis Example Design section.
Updated Table 6.2 and Table 6.3 in the Simulation Example Design section.

Designing and Simulating the IP

Updated the Pin Placement section to remove VREF pin.
Added Pinouts in the Example Design PDC section.
Updated Step 5 in the Preparing the Bitstream section.

Updated Step 3 in the Example Design Simulation section to show the expected error
message for DDR4.

Updated the serial port print outs in the Running on Hardware section.

Appendix B

Removed the pll lock issue.

References

Added DDR Memory Controller Driver (FPGA-TN-02379) in this section.

Revision 1.4, IP v2.4.0, Decembe

r 2024

Section

Change Summary

All

Changed the document title from Memory Controller IP Core for Avant Devices to DDR
Memory Controller IP Core.

Minor editorial fixes.

Abbreviations in This Document

Changed Acronyms to Abbreviations.

Introduction

Updated Table 1.1. Quick Facts.

e  Added Lattice Nexus 2 to the supported FPGA family.

e  Added LAV-AT-E30 and LN2-CT-20 to the targeted device.
Added the IP Support Summary section.

Added Certus-N2 in Table 1.5. Ordering Part Number.

Added the Hardware Support section.

Removed the IP Validation Summary section.

Added Certus-N2 in Table 1.5. Minimum Device Requirements.

IP Parameter Description

Updated Table 3.1. DDR4 General Attributes.
e  Updated the Read Latency attribute and Write Latency attribute.

Added table note 1 — Only devices with speed grades of 2 and 3 can support dual rank
to Table 3.3, and Table 3.15.

Updated Table 3.4. DDR4 Local Data Bus Attributes.

e |D Width —added 1 as the selectable value.

Updated Table 3.5 and Table 3.17.

e  Removed, only single rank is supported under Number of Ranks attribute.
Removed Avant E/G/X in table note 1 of Table 3.13. LPDDR4 General Attributes.
Updated Table 3.16. LPDDR4 Local Data Bus Attributes.

e |D Width —added 1 as the selectable value.

Designing and Simulating the IP

Reworked Constraints section.
Updated Table 7.3. Project Constraints.
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Section Change Summary
Appendix B Added this section.
References Added the DDR Memory Controller IP Release Notes (FPGA-RN-02033) in this section.

Revision 1.3, August 2024

Section

Change Summary

All

Minor editorial fixes
Replaced ModelSim with QuestaSim
Replaced Avant-AT-E/Avant-AT-G/Avant-AT-E with Avant-E/Avant-G/Avant-X

Introduction

Updated Features subsection

e  Updated Avant-E DDR4/LPDDR4 SDRAM speeds
e  Added Dual-rank support

e  Added DDR4 VREF Training
Updated IP Validation Summary subsection

e Added Dual rank to Table 1.5.
Updated Minimum Device Requirements subsection
e  Updated Table 1.6.

Functional Description

Renamed section 2.1.1 Hardened Memory Controller to Memory Controller
Renamed section 2.1.2 Hardened DDRPHY to DDRPHY Module
Renamed section 2.1.2.1 DDRPHY Primitive to 2.1.2.1 Hardened DDRPHY Primitive
Updated AXI4 Data Interface subsection
e  Removed write strobe limitation
e  Updated supported AXI4 transactions
Updated Calibration subsection
e  Added polling for PLL lock signal
Updated Periodic ZQ Calibration subsection
Updated Operation Descriptions subsection

IP Parameter Description

Updated subsections based off Memory Controller IP Core for Avant Devices version
2.1.0

Signal Description

Updated signal name reset_n_ito areset_n_i
Updated Table 4.2 and Table 4.7.

Designing and Simulating the IP

Updated Figure 7.5.

Updated Table 7.1

Updated Pin Placement subsection

. Recommend dedicated PLL reference clock
Updated Constraints subsection

Appendix A. Resource Utilization

Reworked section contents.

Revision 1.2, December 2023

Section

Change Summary

All

Changed the document title from Lattice Avant Memory Controller IP Core - Lattice
Radiant Software to Memory Controller IP for Avant Devices.

Reworked document content and structure for clarity.

Acronyms in this document

Reworked section contents.

Introduction

Reworked section contents.

Reworked section 4 Ordering Part Number and renamed to subsection 1.3 Licensing and
Ordering Information. Added IP Validation Summary and Minimum Device
Requirements subsection.

Reworked subsection 1.3 Naming Conventions and renamed to subsection 1.6 Naming
Conventions
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Section

Change Summary

Functional Description

e  Reworked subsection 2.1. Overview and renamed to subsection 2.1 IP Architecture.

e  Added subsection 2.2 Clocking and Reset.

e  Reworked subsection 2.2.1 AXI4 Interface and moved under added subsection 2.3 User
Interfaces.

e Reworked subsection 2.5. Initialization and Training and renamed to subsection 2.4
Calibration.Reworked subsection 2.6. Operations Details and renamed to subsection 2.5
Operation Descriptions.

IP Parameter Description

Reworked subsection 2.3 Attributes Summary and moved this under IP Parameter
Description section.

Signal Description

Reworked subsection 2.2 Signal Description and converted it to Signal Description section.

Register Description

Reworked subsection 2.4 Register Description and converted it to Register Description
section.

Memory Controller Example
Design

Added this section.

Designing and Simulating the IP

Reworked section 3 IP Generation, Simulation, and Verification and renamed to this main
section.

Appendix A. Resource Utilization

Reworked section contents.

References

Reworked section contents.

Revision 1.1, September 2023

Section

Change Summary

All

e  Changed the document title from 'Avant Memory Controller IP Core - Lattice Radiant
Software' to 'Lattice Avant Memory Controller IP Core - Lattice Radiant Software'.

e  Updated the document to JESD209-4C

Introduction

e  Updated Lattice Radiant Version to 2023.1 in Table 1.1. Quick Facts.
e  Removed 933 MHz and BL32 from the Features section.

Functional Description

e Added AXI4 Interface section under Signal Description.

e  Updated Table 2.2. Supported AXI4 Transactions, Table 2.3. Attributes Table, and Table
2.4. Attributes Descriptions.

IP Generation, Simulation, and
Validation

e  Added Creating a Radiant Project section.

e  Updated Configuring and Generating the IP section for the new IP GUI.
e  Added Figure 3.7 in the IP Evaluation section.

e  Updated the Hardware Validation section.

Ordering Part Number

Updated this section.

Appendix A. Resource Utilization

Updated this section.

References

Updated this section.

Technical Support Assistance

Added reference link to the Lattice Answer Database.

Revision 1.0, November 2022

Section

Change Summary

All

Changed document title to Avant Memory Controller IP Core - Lattice Radiant Software.

Introduction

e  Updated Table 1.1. Quick Facts.
e Added 266 and 933 MHz in the Features section.

Functional Description

e  Updated rst_n_i description and added Note 6 in Table 2.1. Memory Controller IP Core
Signal Description.

e  Updated Table 2.3 Attributes Table.
e  Updated DDR Command Frequency and Write/Read Ordering Queue.
e Added note on supporter frequency per speed grade.

e Improved Enable DBI description in Table 2.4. Attributes Descriptions.

e  Updated Initialization and Training section.
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Section Change Summary
IP Generation, Simulation, and e  Updated subsections in the IP Generation, Simulation, and Validation section.
Validation e  Updated the IP Evaluation section.

e  Updated the Hardware Validation section.

Ordering Part Number Updated this section.
Appendix A. Resource Utilization Updated this section.
References Updated this section.

Revision 0.80, September 2022
Section Change Summary

All Preliminary release
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